User Manual
for Cisco Unified Contact Center Management Portal

Release 8.5(1)

November 2011

Corporate Headquarters
Cisco Systems, Inc.
170 West Tasman Drive
San Jose, CA 95134-1706
USA
http://www.cisco.com
Tel: 408 526-4000
800 553-NETS (6387)
Fax: 408 526-4100
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preface</td>
<td>1</td>
</tr>
<tr>
<td>Purpose</td>
<td>1</td>
</tr>
<tr>
<td>Audience</td>
<td>1</td>
</tr>
<tr>
<td>Organization</td>
<td>1</td>
</tr>
<tr>
<td>Related Documentation</td>
<td>2</td>
</tr>
<tr>
<td>Product Naming Conventions</td>
<td>3</td>
</tr>
<tr>
<td>Conventions</td>
<td>4</td>
</tr>
<tr>
<td>Obtaining Documentation and Submitting a Service Request</td>
<td>4</td>
</tr>
<tr>
<td>Documentation Feedback</td>
<td>5</td>
</tr>
<tr>
<td>1. Welcome</td>
<td>7</td>
</tr>
<tr>
<td>About the Unified Contact Center Management Portal</td>
<td>7</td>
</tr>
<tr>
<td>How does it work?</td>
<td>8</td>
</tr>
<tr>
<td>Getting Started</td>
<td>8</td>
</tr>
<tr>
<td>Web Portal Overview</td>
<td>8</td>
</tr>
<tr>
<td>Host Administrator Tasks</td>
<td>8</td>
</tr>
<tr>
<td>Tenant Administrator Tasks</td>
<td>8</td>
</tr>
<tr>
<td>Tenant User Tasks</td>
<td>8</td>
</tr>
<tr>
<td>Accessing the Online Help</td>
<td>9</td>
</tr>
<tr>
<td>Logging In and Out</td>
<td>10</td>
</tr>
<tr>
<td>Logging into the Web Tool</td>
<td>10</td>
</tr>
<tr>
<td>Logging Out of the Web Tool</td>
<td>11</td>
</tr>
<tr>
<td>Single Sign On</td>
<td>11</td>
</tr>
<tr>
<td>Home Page</td>
<td>11</td>
</tr>
<tr>
<td>Your Home Page</td>
<td>11</td>
</tr>
<tr>
<td>Modes</td>
<td>12</td>
</tr>
<tr>
<td>Changing Your Password</td>
<td>13</td>
</tr>
<tr>
<td>Web Tool Commands and Browser Interaction</td>
<td>14</td>
</tr>
<tr>
<td>Supported Browsers</td>
<td>14</td>
</tr>
<tr>
<td>Using Popup Blockers</td>
<td>14</td>
</tr>
<tr>
<td>2. Settings</td>
<td>15</td>
</tr>
<tr>
<td>Managing Settings</td>
<td>15</td>
</tr>
</tbody>
</table>
Changing Your User Settings ................................................................. 15
  Basic Options .................................................................................... 15
  Advanced Options ............................................................................ 16

Changing the System Settings ............................................................... 16
  Editing System Settings ..................................................................... 16
  Customizing the Top Menu ............................................................... 17

Changing the Security Settings ............................................................ 17
  Editing Security Settings .................................................................... 18

About Settings ..................................................................................... 19

3. Information Notices ........................................................................ 21

Manage Information Notices ............................................................... 21
  Overview .......................................................................................... 21
  Basic Mode Options .......................................................................... 21
  Advanced Mode Options .................................................................. 21

4. Audit Reports .................................................................................. 25

Understanding Reports ........................................................................ 25

Viewing a Report ................................................................................ 26

Managing Reports ............................................................................... 28
  Displaying Reports ........................................................................... 28
  Saving Reports ................................................................................ 28
  Moving Reports .............................................................................. 28
  Managing Parameter Sets ................................................................. 29
  Creating a New Parameter Set ......................................................... 29
  Modifying the Properties of a Parameter Set .................................. 30

Editing a Report .................................................................................. 30

Setting Report Exception Thresholds ............................................... 31
  Creating or Editing a Report Exception Threshold ......................... 31

5. System Manager ............................................................................... 33

Managing the System .......................................................................... 33
  Page Access and Use ....................................................................... 33
  Using Unified CCMP with Other Provisioning Systems .................. 33
  What are Resources? ....................................................................... 33
  What is the System Manager tool? .................................................. 35
  Anchoring Resources ...................................................................... 36

Tree Structures ................................................................................... 36
  Organizing the Tree Contents ......................................................... 36
  Navigating the Folder Tree ........................................................... 37
  Managing the Tree .......................................................................... 37
Resource Folder Tree Panel .......................................................... 37
Panel Access and Use ............................................................... 37
What is a Resource Folder? ........................................................ 37
Creating a Resource Folder ...................................................... 38
Creating Bulk Folders .............................................................. 38
Deleting a Resource Folder ...................................................... 38
Moving a Resource Folder ....................................................... 38

Items Panel .................................................................................. 39
Panel Access and Use ............................................................... 39
List Resource Items ................................................................. 39
Selecting a Resource Item ....................................................... 39
Creating a Resource Item ........................................................ 39
Moving Resource Item(s) ........................................................ 40
Deleting Resource Items .......................................................... 40
Merging Resource Items .......................................................... 40

Details Panel ................................................................................ 41
Page Access and Use ............................................................... 41
Details Tab ................................................................................. 41
Associations Tab ....................................................................... 41
Advanced Tab ........................................................................... 41
History Tab ............................................................................... 41
Status Tab .................................................................................. 42

Resource States .......................................................................... 42
Pending Active ......................................................................... 42
Ready ...................................................................................... 42
Error ....................................................................................... 43
Deletion Pending ...................................................................... 43
Delete Confirmed ..................................................................... 43

Uploading Resources ................................................................. 43
Member Attributes ................................................................. 43
Editing CSV files ................................................................. 43
Template Guide ....................................................................... 43
Data Types ............................................................................... 44
Incorrect Data Type Entry ..................................................... 44
Person Template ................................................................. 45
Agent Template ....................................................................... 46
Folders Template ............................................................... 47
Agent Desktop Template ..................................................... 47
Agent Team Template .......................................................... 48
Enterprise Skill Group Template ........................................... 48
Skill Group Template .......................................................... 49
User Variable Template ........................................................ 49
Using the Bulk Upload Tool ................................................... 50

Agent Management ...................................................................... 51
Managing Persons ............................................................... 51
Preface

Purpose

This document explains how to use the Unified Contact Center Management Portal (Unified CCMP) to manage settings, services, security and your system using the Web Portal tool.

Audience

This document is intended for all users of Unified CCMP, from high-level administrators to team supervisors. The reader needs no technical understanding beyond a basic knowledge of how to use computers.

Organization

The following table describes the information contained in each chapter of this guide.

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 1, “Welcome, see page 7.” Intended Audience: all audiences</td>
<td>Provides basic information on the Unified CCMP environment and how to use the context-sensitive online help.</td>
</tr>
<tr>
<td>Chapter 2, “Settings, see page 15.” Intended Audience: all audiences</td>
<td>Describes how a user can change their settings, or the settings of others, such as email address, time-zone, or security privileges.</td>
</tr>
<tr>
<td>Chapter 3, “Information Notices, see page 21.” Intended Audience: all audiences</td>
<td>Explains how to view and edit information notices.</td>
</tr>
<tr>
<td>Chapter 4, “Audit Reports, see page 25.” Intended Audience: all audiences</td>
<td>Describes how to set up and view audit reports.</td>
</tr>
<tr>
<td>Chapter 5, “System Manager, see page 33.” Intended Audience: all audiences</td>
<td>Describes the folder structure of Unified CCMP and explains how to set up and maintain agents, contacts, equipment, and other resources using Unified CCMP.</td>
</tr>
<tr>
<td>Chapter 6, “Security Management, see page 85.” Intended Audience: all audiences</td>
<td>Explains how to set up security settings for individual users by means of roles and tasks, and how users with the same permissions can be added to groups to simplify management.</td>
</tr>
<tr>
<td>Chapter 7, “Service Management, see page 95.” Intended Audience: all audiences</td>
<td>Explains how supervisor users can use Unified CCMP for management of agents, teams, and skill groups.</td>
</tr>
</tbody>
</table>
Related Documentation

Documentation for Cisco Unified ICM/Contact Center Enterprise & Hosted, as well as related documentation, is accessible from Cisco.com at: http://www.cisco.com/cisco/web/psa/default.html.

- Related documentation includes the documentation sets for Cisco CTI Object Server (CTIOS), Cisco Agent Desktop (CAD), Cisco Agent Desktop - Browser Edition (CAD-BE), Cisco Unified Contact Center Management Portal, Cisco Unified Customer Voice Portal (CVP), Cisco Unified IP IVR, Cisco Unified Intelligence Center, and Cisco Support Tools.

- For documentation for these Cisco Unified Contact Center Products, go to http://www.cisco.com/cisco/web/psa/default.html, click Voice and Unified Communications, then click Customer Contact, then click Cisco Unified Contact Center Products or Cisco Unified Voice Self-Service Products, then click the product/option you are interested in.

- For troubleshooting tips for these Cisco Unified Contact Center Products, go to http://docwiki.cisco.com/wiki/Category:Troubleshooting, then click the product/option you are interested in.

- Documentation for Cisco Unified Communications Manager is accessible from: http://www.cisco.com/cisco/web/psa/default.html.


- The Product Alert tool is accessible from (login required): http://www.cisco.com/cgi-bin/Support/FieldNoticeTool/field-notice.


### Product Naming Conventions

In this release, the product names defined in the table below have changed. The New Name (long version) is reserved for the first instance of that product name and in all headings. The New Name (short version) is used for subsequent instances of the product name.

**Note** this document uses the naming conventions provided in each GUI, which means that in some cases the old product name is in use.

<table>
<thead>
<tr>
<th>Old Product Name</th>
<th>New Name (long version)</th>
<th>New Name (short version)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco IPCC Enterprise Edition</td>
<td>Cisco Unified Contact Center Enterprise</td>
<td>Unified CCE</td>
</tr>
<tr>
<td>Cisco System IPCC Enterprise Edition</td>
<td>Cisco Unified System Contact Center Enterprise</td>
<td>Unified SCCE</td>
</tr>
<tr>
<td><strong>Note:</strong> Cisco Unified System Contact Center Enterprise (Unified SCCE) is supported in 8.5(1); however, there is not a separate 8.5(1) version. If you request features that are in 8.5(1), you must migrate to the Unified ICM/CCE/CCH software. Full migration information is documented in the Upgrade Guide for Cisco Unified ICM/Contact Center Enterprise &amp;Hosted.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cisco IPCC Hosted Edition</td>
<td>Cisco Unified Contact Center Hosted</td>
<td>Unified CCH</td>
</tr>
<tr>
<td>Cisco Intelligent Contact Management (ICM) Enterprise Edition</td>
<td>Cisco Unified Intelligent Contact Management (ICM) Enterprise</td>
<td>Unified ICM</td>
</tr>
<tr>
<td>Cisco Intelligent Contact Management (ICM) Hosted Edition</td>
<td>Cisco Unified Intelligent Contact Management (ICM) Hosted</td>
<td></td>
</tr>
<tr>
<td>Cisco CallManager/Cisco Unified CallManager</td>
<td>Cisco Unified Communications Manager</td>
<td>Unified CM</td>
</tr>
</tbody>
</table>
Conventions

This manual uses the following conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
</table>
| **boldface** font | Boldface font is used to indicate commands, such as entries, keys, buttons, folders and submenu names. For example:  
- Chose **Edit > Find**.  
- Click **Finish** |
| **italic** font | Italic font is used to indicate the following:  
- To introduce a new term; for example: A *skill group* is a collection of agents who share similar skills.  
- For emphasis; for example: *Do not* use the numerical naming convention.  
- A syntax value that the user must replace; for example: IF (*condition*, *true-value*, *false-value*)  
- A book title; for example: Refer to the *Cisco CRS Installation Guide* |
| **window font** | Window font, such as Courier, is used for the following:  
- Text as it appears in code or that the window displays; for example: `<html><title>Cisco Systems, Inc. </title></html>`  
- Navigational text when selecting menu options; for example **ICM Configuration Manager > Tools > Explorer Tools > Agent Explorer** |
| `< >` | Angle brackets are used to indicate the following:  
- For arguments where the context does not allow italic, such as ASCII output  
- A character string that the user enters, but does not appear on the window such as a password |

Obtaining Documentation and Submitting a Service Request

For information on obtaining documentation, submitting a service request, and gathering additional information, see the monthly *What’s New in Cisco Product Documentation*, which also lists all new and revised Cisco technical documentation, at:


Subscribe to the *What’s New in Cisco Product Documentation* as a Really Simple Syndication (RSS) feed and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free service and Cisco currently supports RSS version 2.0.
Documentation Feedback

You can provide comments about this document by sending email to the following address:

mailto:ccbu_docfeedback@cisco.com

We appreciate your comments.
1. Welcome

About the Unified Contact Center Management Portal

Unified Contact Center Management Portal (Unified CCMP) is a browser-based management application designed for use by contact center/system administrators, business users, and supervisors. It is a dense, multi-tenant provisioning platform that overlays the contact center equipment. The contact center equipment is viewed as consisting of configuration items, generally known as resources, such as agents or skill groups, and events logged when the resources are used by the equipment, such as call record statistics.

Unified CCMP partitions the resources in the equipment using a familiar folder paradigm, and these folders are then secured using a sophisticated security structure that allows administrators to specify which users can perform which actions within the specified folder(s). Unified CCMP supplies a number of tools that operate on the configuration and statistics data. The tools are all inherently multi-tenanted and those currently supported are:

- **Information Notices** tool that implements the "Message of the Day" functionality, on page 21.
- **System Management** tool that implements the resource partitioning strategies and provisioning operations, on page 33.
- **Security Management** tool that implements the user and group task/role based security strategies, on page 85.

Unified CCMP's focus on supplying dense, multi-tenancy functionality supports the business plans of hosts and large enterprises as it allows the distributed or disparate contact center equipment to be partitioned or segmented to satisfy the following business goals:

- Unified CCMP abstracts and virtualizes the underlying contact center equipment, thereby allowing centralized deployment and decentralized control, which in turn gives economies of scale while supporting multi-level user command and control.
- Unified CCMP allows the powerful and flexible native Unified CCE provisioning operations to be abstracted into simple, high level tasks that enable business users to rapidly add and maintain contact center services across the virtualized enterprise (or portion thereof).
- A Portal user sees only the resources in the platform that he/she is entitled to see, thereby providing true multi-tenancy.
- A Portal user can manipulate only those resources visible to them by using Unified CCMP tools and features he/she has been authorized to use, thereby providing role-based task control.
How does it work?
Unified CCMP maintains a complete data model of the contact center equipment to which it is connected, which is periodically synchronized with the equipment. Unified CCMP data model and synchronization activity allow for items to be provisioned either through Unified CCMP's Web interfaces or from the standard equipment-specific user interfaces.

Getting Started

Web Portal Overview
Web Portal maintains that there are a small number of user classes:
• Host administrator
• Tenant administrator
• Tenant user
On a new system, the host and tenant administrators perform their respective tasks before the tenant user is given access to the system. These tasks are detailed below.

Host Administrator Tasks
The Host administrator is responsible for the whole platform and therefore has a view across all the equipment, tenants and their resources. They are responsible for the following activities:
• Ensuring that the tenant equipment (peripherals) are correctly located in the tenant or Shared folders.
• Creating an administrator user for each tenant.
• Adding tenant administrators to the tenant administrators group and assigning any specific roles.

Tenant Administrator Tasks
The tenant administrator is responsible for the part of the system assigned to that tenant by the host administrator. They are responsible for the following activities:
• Creating a resource folder structure that maps onto the tenant's business.
• Moving the tenant's resources into the relevant subfolders.
• Creating security groups that provide the required role-based access to the subfolders.
• Creating the required number of users and assigning users to the security group(s) relevant to the user’s role.

Tenant User Tasks
The tenant user (usually just called the user) is created by the tenant administrator. A tenant user has access just to the resources and tools assigned by the tenant administrator. Several sub-classes of tenant user can be created by the tenant administrator using user groups and roles to achieve business requirements; for
example one class of users might be able to add information notices. Tenant users are able to:

- View or manage information notices.
- Select the Information Management tool.
- Manage users/security groups.
- Select the Security Management tool.
- Manage resources (dimensions).
- Select the System Management tool.
- View or manage audit reports.
- Select the Reporting tool.
- Perform re-skilling or agent team changes
- Access the Service Manager tool.

**Accessing the Online Help**

For security purposes, the online help is available only after the user logs in. To open the online help, click the Help link in the top right corner of the screen. The help provides:

- Instructions for using, provisioning and managing the system.
- A comprehensive glossary.
- Logical indexing to help you quickly find the sections you need.
- Search facilities.

The help window consists of a main panel in which the section text displays. To the left of the main panel are four tabs. Click the tab header to display the tab contents. The tabs are as follows:

- **Contents** displays the section list as a table of contents, to help you locate the section you require.
- **Index** lists the keywords that you can use to find related sections.
- **Search** enables you to search through all the sections for a particular word or phrase. Enter the text in the field provided and click **Go**. A list of all the sections in which the text occurs are then listed. You can also use the search field displayed in the top right of the window.
- **Glossary** comprehensively covers and explains the terms and entities comprising Unified CCMP.
Logging In and Out

Logging into the Web Tool

To log in to the system:

1. Open your web browser and enter the URL address of the web server in the browser's address field.
   This will be in the format: http://<Portal server>/portal
   Or for SSL deployments: https://<Portal server>/portal
   For example, one possible web server address might be: https://webserver1/portal

2. The security access banner displays to inform the user that access to the platform is restricted to authorized users.
   **Note** this banner can be changed by the administrator for the whole platform to meet the needs of the specific deployment. (For further information see the Change Your System Settings section.)

   **Note** If your system has been set up to use Single Sign On (SSO), the login page will not display. See the Single Sign On section for more details.

3. Click **agree** to display the Login page.

4. Enter your **User Name** and **Password** details in the fields, then click **Login**. A successful login opens the user's home page.

   **Note** before using the system for the first time, the **User Name** for the host administrator is automatically set to **administrator**, with a blank password. Set a new password immediately.

   **Note** if you do not perform any action on the system for twenty minutes, the system automatically logs you out.

   If the web page is already open, click **Logout** to log out the previous user and display the normal login window.

First Time Users

- The first time you access the Web Tool you might be prompted to accept a security certificate. Accept this security certificate and then proceed.

- After you have first logged in, you might have to change your password. If prompted to change your password, do so immediately, otherwise further access will be denied. For further information see the Change Password section.

  **Note** the password field is case sensitive. If you have difficulty logging in, make sure that you have not accidentally clicked **Caps Lock** key.

For tips on how to create a secure password that you can remember, see the Change Your Password section.

By default, you have a maximum of three attempts to log in to the system correctly. If, after three attempts, you still have not logged in correctly, your user account will be locked out. If this is the case, contact the administrator responsible for re-enabling it.
The system automatically logs out a user when the web browser window closes.

**Logging Out of the Web Tool**

Once your user session finishes, close your browser session to ensure that no other user can interfere with your account.

To log out of the tool, click the **Logout** button located on the top right side of your browser window. Alternatively, close the web browser window to log out automatically.

**Single Sign On**

The administrator might have set up Unified CCMP such that it recognizes the Windows users who are able to access it. In this case, as long as you are logged in to Windows as yourself, you do not need to log in to Unified CCMP at all.

The first time you access Unified CCMP using Single Sign On (SSO), a window might pop up, requesting your Windows username and password. To sign in automatically in future, you need to add Unified CCMP website to your browser's list of local intranet sites.

To do this in Internet Explorer:
1. Click **Tools > Internet Options** and click **Security** tab.
2. Select the **Local intranet** icon and click **Sites**.
3. Click the **Advanced** button to add the Unified CCMP site to IE's list of local intranet sites.
4. Enter the Unified CCMP website’s URL and click **Add**.
5. Click **Save** on each pop-up until you return to the browser window.

**Home Page**

**Your Home Page**

Once you have logged in, you are presented with your personalized home page, which is the launch pad for accessing the rest of the system.

*For a basic mode user,* the main central panel displays your most frequently used reports, which are organized into related report groups. For further information, see the Basic Mode Options section, on page 12.

*For an advanced mode user,* the main central panel displays the system management functions that you can access. For further information, see the Advanced Mode Options section, on page 12.

The **Toolbar** at the top right of the screen displays further functions, which vary depending upon the system functions you are using and the permissions granted to you.

The very top of the page displays a list of the pages you have navigated through to access your current page. This is called the breadcrumb trail. Each page in the trail displays as a link to help you quickly return to previous pages.

To the right of the breadcrumb trail the following options display:

- **Home** Click to return to your homepage.
• **Help** Click to display the online help. It contains everything you need to understand and use the system features, reports and report analysis. See the Online Help topic.

• **Settings** Click to select the settings you need to change. See the Manage Settings section.

• **Logout** Click to end your session. See the Logging In and Out section.

If any of these terms are unfamiliar to you, refer to the **Glossary**.

**Modes**

There are two modes in which Unified CCMP can be used.

• **Basic users** need to view reports and define their own user settings, but do not require system management functions.

• **Advanced users** can navigate the folder tree. Advanced users manage the system and the resources it contains, system reports and analyses, as well as defining the users who can access the system and their user rights.

**Basic Mode Options**

On logging in, if you are a basic user (or if you are an advanced user using *basic mode*) you see a flat list of the reports you have access to or, if you do not have access to reports, your team management page. You can return to this page by clicking **Home** at the top right of the screen.

In the bar above the list of reports are a number of menu options:

• **Delete** - deletes selected reports.

• **Run** - runs selected reports.

Next to **Home** in the header, a shortcut menu displays the following links:

• **Agent Team Manager** - allows you to manage your agent teams.

• **Skill Group Manager** - allows you to manage your skill groups.

• **Users** – allows you to manage the users in your folder.

• **Self-Skilling** – allows you to manage the skills to which your associated agent is assigned.

**Note** some of the above mentioned links are only available if the appropriate permissions and memberships exist.

**Advanced Mode Options**

Advanced users require access to system management functions. To access these functions, you must be in **advanced mode**.

To switch between basic mode and advanced mode, click **Settings > User Settings**. Check **Advanced Mode** in the middle of the user settings to view the functions you have access to. This is the **Tools** page.

You can set a commonly-used tool to be your homepage using the **Settings** page.

Which tools you can use depends on your security permissions, as determined by the *global and folder roles* that have been assigned to you.
Shortcuts to all of the tools available to you are in the menu located next to **Tools** in the header.

**Note** if you think you require access to some of these tools but cannot see them in the **Tools** page, contact your system administrator.

- **Reports** section enables you to view and manage audit reports, which provide information about changes made to the system.

- **Security Manager** enables you to create and manage users and groups, their roles, which define the tasks they may perform and manage security; the customer data and system functions they may access.

- **System Manager** enables you to provision and manage the entire system, the reports and the resources they report on.

- **Information Notices** enables you to create and manage online notices; a messaging feature which informs and updates system users with important information.

- **Service Manager** enables a user with the appropriate agent mapping to manage skill groups and agent teams for either themselves or for other members of a team that they are supervising.

Further advanced functions include:

- **Settings** the creation and administration of system, display, user and password settings. See Managing Settings section, on page 15.

**Changing Your Password**

To display the **Settings** page, click **Settings**. Click **Change Password**. The Change your password settings page displays.

You will need to change your password if:

- You have logged into the Web Portal for the first time.

- The system has been configured to request you to change it after a specific length of time.

- Your password has become known to others.

To change your password:

1. Enter your **Old Password**.
2. Enter your **(New) Password**.
3. Re-enter your new password in the **Confirm Password** field.
4. Click **OK**.

**Note** your password must normally consist of at least 3 characters. There may also be other requirements, commonly that it must include lower case letters, upper case letters and numbers. Contact your system administrator for more details.

**Note** your previous passwords are stored in memory, therefore you cannot reuse passwords.

**Tip** You can create a password that is both memorable and secure by choosing a memorable phrase such as a proverb or a line of your favorite poem, selecting the first letters of each word in that phrase, and turning some of those letters into
numbers. For example, the proverb 'a chain is no stronger than its weakest link' shortens to 'acinstiwl', which can be turned into a password 'AC1Inst1WL' which is easy to remember but difficult for a hacker to crack.

Web Tool Commands and Browser Interaction

**Supported Browsers**

This Web Tool is designed for use with Internet Explorer 6 (SP2) or later.

If you are working on a computer running Windows Server 2000, you will need to use Internet Explorer (IE) 7.

**Using Popup Blockers**

This Web Tool may be adversely affected by browser or third-party popup blocking utilities. When using this tool, either disable popup blocking or exclude this tool's domain from popup blocking.

To disable popup blocking (in other words, to enable popups) in Internet Explorer (IE):

1. Click **Tools** and select **Internet Options**.
2. Select **Privacy** tab.
3. At the bottom of the window, click **Block pop-ups** to remove the checkmark. If the box is already empty, leave it as it is.
4. Click **OK**.

Alternatively, you can enable popups for the Web Tool only. To do this using IE, use the Web Tool normally until a message displays at the top of the browser window telling you a popup has been blocked. By clicking on this you may choose to permanently allow popups from the Web Tool, while still remaining protected against popups from other sites.

Different browsers have different methods of disabling popup blocking.
2. Settings

Managing Settings

To display the Settings page, click Settings link at the top right of the page. The settings that you can customize are as follows:

- **User Settings** enable you to change your time-zone, name and description. Advanced users may also change their homepage settings.
- **Password Settings** enable you to change your password.
- **System Settings** enable users with host administrator privileges to set system options such as the login message.
- **Security Settings** enable users with host administrator privileges to set system security options such as password requirements or the default security groups created in each policy root.
- **About** enables you to see the version of Unified CCMP that is being used.

Changing Your User Settings

Basic Options

To display the Settings page, click Settings, and then click User Settings. The Update settings for this user page displays.

To change your user settings, select or overwrite the required fields and click OK. These fields are explained below.

- **Time-zone** Select your local region from the drop-down list.
- **Culture** Select the culture from the drop-down list of available cultures. This changes date/time formats in the application and localizes the user interface for cultures with a supporting language pack.
- **First Name** and **Last Name** Change your name. You may want to do this if you are married, or if you normally use a name other than the First Name entered here (such as a middle name).
- **Email** Enter the email address you want Unified CCMP to send your emails to, if any.
- **Description** Enter a suitable description of yourself (such as job title or departmental role).
- **Data Paging Size** This field dictates the number of selected items displays per page, for example in the central Items panel of the System Manager. Numbers above 20 are not recommended.
- **Text Only Mode** Check this box to set your display to a simplified text-only view. You must log out and log back in for your display to change.
Advanced Options
If you have sufficient security credentials, you can access further functions. Select or overwrite the required fields and click OK. These fields are explained below:

- **Advanced Mode** This checkbox changes your homepage view from a set of reports (this view is the only view possible for basic users) to the homepage specified by the Default Homepage field below. By default, this will be a view of the tools you have access to.
- **Show Deleted Resources** Check this checkbox to view all deleted items you have permission to see, or uncheck it to view only active and pending items.
- **Default Tool** Allows you to change your homepage. Select a tool from the drop-down menu to display that tool as your homepage when you are in Advanced Mode. To see all your tools in your homepage, select the Tools View.
- **Tools Layout** Allows you to change the format of the Tools Page. You may choose between a list of tools or a table.

Click OK to save your settings.

Changing the System Settings
Typically, only a user with sufficient permissions has the right to access and manage system settings. System settings mostly enable a user to define user password requirements.

To display the Settings page, click Settings and then click System Settings.

Editing System Settings
To edit the system settings:

1. Display the System Settings page as described above.
2. Change any or all of the following:
   - **Product Name** field displays the name of the application.
   - **Login Message** field contains the message displayed to a user when the user logs into the system. By default a WYSIWYG editor is used, but by clicking on the <> button you can choose to work in plain text or insert your own HTML tags instead.
     
     **Note** the login message must not exceed 250 characters in the default 8pt font.
   
     **Note** to use the WYSIWYG editor to format the login message, you must highlight the text to be formatted and use the appropriate editor function. The editor functions do not allow you to format the text as you type, that is, clicking the I button (for example) will not ‘switch on’ italics mode for the text typed afterwards.
   
   - **Message Agreement Link** field contains the text shown on the button that the user must click to proceed from the login message set above to the login page. This text must be no longer than 40 characters.
Customizing the Top Menu
To add your own links to the top menu (the options displayed at the top right of every page):

1. Click Customized Top Menu in the toolbar to open the Customize Top Menu page.
2. In Create a new menu item section:
   - Name enter the text to be shown in the top menu.
   - Link enter the URL to link to. You can check that this is valid by clicking on the icon to the right.
3. Click Add.
   Note Changes to the top menu are system-wide and will be applied to all tenants.

Editing Existing Custom Links
To edit existing custom links:

1. Click Customized Top Menu in the toolbar to open the Customize Top Menu page.
2. In the Existing editable menu items section at the bottom all custom links are listed.
3. Mouse over each to access the Edit and Delete icons.
4. Click Edit (pen and paper) icon.
5. Change the link details as desired.
6. Click Check to save your changes, or Cross icon to exit editing without saving.

Deleting Existing Custom Links
To delete existing custom links:

1. Click Customized Top Menu in the toolbar to open the Customize Top Menu page.
2. In the Existing editable menu items section at the bottom all custom links are listed.
3. Mouse over each to access the Edit and Delete icons.
4. Click the delete (red cross) icon and confirm.
5. Click Back to return to the System Settings page. This removes the custom link.

Changing the Security Settings
Typically, only a user with host administrator permissions has the right to access and manage security settings. Security settings cover all aspects of system security, from password restrictions to security groups.

To change the system's security settings, click Settings and then click Security Settings.
Editing Security Settings

- If New Folder Inheritance Default field is checked when creating new folders, the Inherit Permissions field is checked by default.

- Password Format field contains the required format for the password entered by a user. The options are:
  - Custom this is for users with high privileges only. It requires regular expressions and a knowledge of system configuration.
  - Low any string.
  - Medium any string between the minimum and maximum password length.
  - Medium/High any string between the minimum and maximum password length, which must contain lowercase, uppercase and numeric values.
  - High any string between the minimum and maximum password length, which must contain lowercase, uppercase, numeric values and any of the following characters: @ # $ % ^ & + = !

- Minimum Password Length field indicates the minimum number of characters the system will accept as valid for a password.

- Maximum Password Length field indicates the maximum number of characters the system will accept as valid for a password.

- Minimum Password Age field shows how long a user must wait between changing passwords.

- Password Expiry (days) field displays the length of time the system will accept a password before the user is requested to change it.

- Number of previous passwords to check field displays the number of previous passwords the system accepted for a specific user. If any one of these previous passwords is used, the user will be denied further access to the system.

- Login attempts before lockout field indicates the number of times a user can enter the wrong password before being locked out of the system.

- User Folder Default Role specifies the permissions that a new user is given on the folder that is created when the Create a new folder for this user option is checked during user creation. Note that you still need to provide the correct global roles.

- Optionally, the User Folder Suffix field allows you to choose a suffix which, when added to a user's name, becomes the name of the personal folder created when Create a new folder for this user is checked during user creation. This is disabled when using single sign on.

- Groups to create when removing inheritance section allows you to change the groups that are automatically created when a folder becomes a policy root, and the permissions that they are assigned within that folder and its child folders. You may choose to uncheck all the groups, in which case no groups will be created automatically, or to assign them custom roles. See the Security Manager section for more information on policy roots.

Note it is not currently possible to change the global roles that groups are assigned by default. The Basic User and Supervisor User groups will therefore always have the
permissions of the Basic global role, and the Advanced User group will have the permissions of the Advanced global role.

Click OK to save your settings.

**About Settings**

To display the Settings page, click **Settings** and then click **About**.

The About this installation page describes the version of Portal that you have installed on your system.
3. Information Notices

Manage Information Notices

Overview
Information notices (also sometimes called system notices) are similar to a notice board or Message of the Day feature. Information notices are a useful way to inform all contact center staff of general information in one action and in one location, rather than having to inform each staff member individually. Notices typically include changes to agent assignments or important customer information. Once you have logged in, any information notices that apply to you are displayed in your homepage in a scrolling window at the top right corner of the screen.

Basic Mode Options
To view an information notice:
1. Click your mouse pointer over the information notices icon located at the bottom right hand side of the basic mode home page. A list of information notices displays.
2. Click the name of the required notice from the list. The notice text displays in full.
3. Once you have finished reading the notice, click Cancel.

Note
- The information notices panel will only display current or valid notices. Notices that are out-of-date or pending are not displayed.
- If you have sufficient user privileges, you can edit the notice. Click Edit this Notice.... Further information can be found in the Advanced Mode Options section.

Advanced Mode Options
To open the Information Notices tool as your homepage:
1. Click Settings.
2. In Settings page, select User Settings.
3. Select Information Notices from the Default Homepage drop-down list.
4. Click OK.
5. Click Home. The All System Notices page displays.

Alternatively, you may access the Information Notices section by clicking Tools. The Tools page displays and then click Information Notices header. The All System Notices page displays.

Note the Tools page can only be accessed by users who have been granted Advanced Mode status. See the User Settings section.

To create an information notice:
1. Click **New**. The New System Notice page displays.

![Cisco Unified Contact Center Management Portal](image)

2. Select the folder in the tree whose users are the target audience for the new notice. The folder name displays at the top of the page. Then perform the following:

   - **Subject** field, enter a title for the notice.
   - **Content** field, enter the text. You can format the text as required by using the editor functions displayed above the text field. Functions include: text formatting, justification, bullet points and numbering, indenting, web linking and table add-ins. Click <> icon to remove the editor functions or display them if they have been removed from the view.
   - **Valid From** and **Valid To** fields, enter start and end dates to define the lifetime of the notice by clicking on the calendar icons and selecting the appropriate months and days.
   - Select **Create Another** checkbox if you wish to add another notice after creating the current notice.

3. Click **Save**.

Alternatively, click **Tools**, the Tools page displays. Click **Create a Notice**, the New System Notice page displays, and you may proceed as per the bulleted list above.

**Editing an Information Notice**

To edit an information notice:

1. Click the name of the notice to be modified beneath the Information Notices header, the notice displays.

2. Click **Edit**, the Edit Information Notices page displays.

3. Make the required modifications to the notice in the fields provided, as explained for creating an information notice above.
You may also edit an information notice by clicking **Tools**, the Tools page displays. Select the notice to be edited from the **Edit a Notice** drop-down list and click **Edit**. The Edit Information Notices page displays and you can make the required changes and click **Save**.

**Note** to format the information notice, you must highlight the text to be formatted and use the appropriate editor function. The editor functions do not allow you to format the text as you type, that is, clicking the *I* button (for example) will not 'switch on' italics mode for the text typed afterwards.

**Deleting an Information Notice**

To delete an information notice, click the red cross displayed next to the name of the notice to be deleted.

Alternatively, click the name of the notice where it displays beneath the Information Notices header. The notice displays. Click **Delete**.

To move an information notice:

1. Click **Tools**. The Tools page displays.
2. Click **System Manager**. The System Manager page displays.
3. Select the folder in the tree whose users or groups are the audience for the intended notice.
4. In the **Items** drop-down list select **Information Notices**. All the information notices for the selected folder displays.
5. Select the checkbox of the notice you want to move and click **Move**. The folder tree displays.
6. Select the folder to move the notice to and click **Save**.
4. Audit Reports

Understanding Reports

A report is a 'snapshot' or overview of contact center operations; the customers, their resources and the agents (and agent groups) who provide them with customer service. Reports enable users to understand what is happening in the contact center; they provide information for auditing purposes.

A report is a combination of three factors:

- **Report Data** consists of resources (such as Dialed Numbers) and the agents who provide Customer Service. These entities are stored in a hierarchical folder structure or Report Tree.

- **Report Template** determines the exact ways in which the report can display data, and the data that it displays. Four audit report templates are included with Unified CCMP. These are:
  - **Audit Data Report** shows every change to a resource that has occurred within the system during the specified time period. This includes the name of the resource, the name of the user who made the edit, and whether the change was successful.
  - **Daily Audit Summary** summarizes the changes made to resources during the day, showing the percentage and total of successful and failed changes at different times for individual items.
  - **Weekly Audit Summary** summarizes the changes made to resources during the last week, showing the percentage and total of successful and failed changes on different days for individual items.
  - **Monthly Audit Summary** summarizes the changes made to resources during the last month, showing the percentage and total of successful and failed changes on different days for individual items.

- **Report Parameters** provide the means of controlling the type and amount of information you wish to see in your report, as well as determining how the report displays. Not all reports have the same parameters. However, some common parameters are as follows:
  - **Sort Column** is used to arrange the report columns so that you can focus on the column data which is of interest to you.
  - **From Date and To Date** is the start and end dates of the time period covered by the report.
  - **Rows per page** is the maximum number of report table rows displayed per page.
Viewing a Report

A report displays as a table; column headers display the name of the resources whose data is used in the report, for example agent or dialed number, and the rows display the data values for each column header.

Once you have logged in, all of the reports which you can view are displayed.

To open a report:

1. Select a report from the report group list(s) in your homepage by clicking the underlined report name. The View Report page displays.

   Alternatively, you may open the report in one of the following formats, by clicking the associated icon:
   - **PDF** click to display the report in an Adobe Portable Document Format.
   - **Excel** click to display the report in an Excel spreadsheet.
   - **Enhanced HTML Renderer** click to display the report in HTML format.

2. Before the report can be displayed, select the parameters that apply to the selected report. These help you control how the report displays, the report format, and how to search through the report data. Options include the following:
   - **Parameter Set** to view the audit report for. Some audit reports require parameter sets based on certain resource types. In these cases the resource type (such as Tenant) displays instead. The default <new> must be changed to a parameter set before you can run the report.
   - **Show only exceptions** if you check Yes radio button, only items outside the report's exception thresholds display, and it will be necessary to set exception thresholds to see any data.
   - **Header Text** set a subtitle displays under the main report title. This must explain the purpose of the report, for example 'Successful provisioning operations'.
   - **Date/Time From/To** the time periods that display in this report. You can choose to either set specific dates (Absolute) or set the date to Yesterday, Last Week and so on (Relative).
   - **Sort On** select which field orders the report is based on. This must be the aspect of the report that interests you most. For example, if you are most interested in which provisioning operations have failed, you must sort the report by Event Outcome, which will group the data into Success and Failure within each resource type.
   - **Sort Order** sets the field to sort on alphabetical (Ascending) or reverse alphabetical (Descending) order.

The following options are available from the toolbar:

- **Edit** enables you to modify the report details (not the report contents). For further information see the Edit a Report section.
- **Save** saves the changes you have made to the report's parameters.

Click **Create Link** to display the details of the report to be saved.
Note by linking a report the new report version is automatically linked back to the original report in the system.

- Then perform the following:
  - **Name** field enter a unique name for the new report.
  - **Question** field enter a question which reflects the report contents, such as 'How many provisioning operations have failed?'
  - **Delete** removes the report from the system.
  - **Thresholds** allow you to set thresholds for the report.

**Caution** a report saved under a different name shares the same references as the original and is therefore linked together in the system. Deleting a report may result in all linked reports being deleted.

3. Click **View Report**. The following options become available:

- If the report is too large to display on one page, it displays across multiple pages. You can enter the number of the required page in the page number field or use the forward and backward navigation buttons to locate the page you need.

- The displayed report can be resized on the screen. Select the report size from the drop-down list. 100% indicates that the report displays at the size it would be if printed.

- **Search** field is used to look for specific items within the report. Enter the name or value you are looking for and click **Find**. The first occurrence of the data displays. If the item occurs more than once, click **Next** to go to the next occurrence.

- Select the format you wish to view the report in from the drop-down list. The following options are available:
  - **Extensible Markup Language (XML)** the report displays as pure XML script. This is useful if the report data is to be imported into a different system and can also be used with later versions of Microsoft Office to create Excel spreadsheets or Access databases.
  - **Comma Separated Variable (CSV)** the report displays in a spreadsheet, with all data values separated by a comma.
  - **Acrobat Portable Document Format (PDF)** this format enables you to distribute and print the report on any machine, provided the Adobe Acrobat reader software is installed.
  - **Excel** The report displays in a Microsoft Excel spreadsheet, which is useful if you wish to manipulate the report values at a later date.

- Click **Export** to view the report in the selected format.

- Click **Refresh** to update the data displayed in the report.

- On the upper right of the **Report Parameters** panel, click the double arrow icon to hide. Click this to hide the parameters section of the page. This is useful if you have a large report and need the full screen to display it.
You may also open the report by clicking **Tools > View Reports**, selecting the folder in the tree which contains the report to be viewed, and selecting the correct report from the list.

**Note** the Tools page can only be accessed by users who have been granted Advanced Mode status. See the User Settings section.

**Managing Reports**

Report management involves moving reports within the Web Portal folder tree. Reports can be moved individually or in bulk. System users with sufficient security privileges can also edit multiple reports in one operation.

**Displaying Reports**

To display the Reports section:

1. Click the name of the report in your homepage. The View Report page displays.
2. Select the folder in the tree which contains the required report. A list of reports displays for the selected customer/folder.
3. Select the required report. The View Reports page displays.
4. Select the required parameters.

Alternatively, click Tools. The Tools page displays. Click View Reports. The View Reports page displays. Then proceed as above.

**Note** The Tools page can only be accessed by users who have been granted Advanced Mode status. See the User Settings section.

**Saving Reports**

To save a report, click **Save**.

To save a report into a specified location:

1. Click **Create Link**. The Create Link Report page displays
2. Select a folder location where the new report will be saved. Then perform the following:
   - **Name** field enter a name for the new report (parameter set).
   - **Sub Title** field enter a simple question which reflects the report contents; this is used as the displayed title for the report. For example, 'How many calls are queued?'
3. Click **OK**.

**Moving Reports**

To move a report:

1. Click **Edit**. The Edit Report Details page displays.
2. Click **Move**. The folder tree displays in a new section.
3. Select the folder to move the report to and click **OK**.
To delete a report, click **Delete** or click the red cross displayed alongside the report name in your homepage.

To print a report, click the **Print** icon. The Printer window displays. Select the print parameters and click **OK**.

**Managing Parameter Sets**

Parameter sets determine which data displays. For example, a report parameter that is a single tenant will produce a report that displays only data associated with that tenant.

To display the report's parameter sets:

1. Click **Parameter Sets**. The Parameter Sets page displays.
2. Select a folder. All the parameter sets for the selected folder display. The following options are available in the toolbar:
   - New
   - Delete
   - Move

**Creating a New Parameter Set**

To create a new parameter set:

1. Click **Parameter Sets**. The Parameter Sets page displays.
2. Select a folder. All the parameter sets for the selected folder display.
3. Click **New** to display the Create a new parameter set page.
4. Select the item type to view from the **Item type** drop-down list.
5. Click **Create Parameter Set**.
6. From the **Folders** tab, select the folder containing the resources, and choose whether you will be adding items in subfolders as well.
7. From the **Resources** tab, select the resources. You may choose to see resources only from the folder you have selected, or also from its sub folders.
8. Click **Add** to add the specified resources to the parameter set.
9. You may also remove resources from the parameter set by checking them and clicking **Remove**.
10. Select the **Save As** option.
11. In the **Name** field enter a name for the new report (parameter set).
12. Click **OK**.

**Note** if a report is specified as using a particular type of parameter, such as tenant, you will not be able to use parameter sets that use different resource types, like Agent or Agent Team, with that report.
Modifying the Properties of a Parameter Set
To modify the properties of a parameter set:
1. Click Parameter Sets. The Parameter Sets page displays.
2. Select a folder. All the parameter sets for the selected folder display.
3. Click Properties icon that displays next to the required parameter set. The Edit an existing parameter set page displays. Then perform the following:
   - Name field modify the name of the report.
   - Click Enabled checkbox to ensure that the report is available to system users.
   - Click Hidden checkbox to prevent users from accessing it.
4. Click OK.

Deleting a Parameter Set
To delete a parameter set:
1. Click Parameter Sets. The Parameter Sets page displays.
2. Select a folder. All the parameter sets for the selected folder display.
3. Check the box of the parameter set (or sets) you wish to delete.
4. Select Delete option.
5. Click OK.

Editing a Report
The Web Portal provides the basic reports you need in order to understand your operations. You can, however, edit a report by selecting an existing report and modifying the parameters that define it. Parameters enable you to control the type and amount of information displayed in your report and the way in which it is presented.

Note when editing a report, you cannot change the type of resource, for example from dialed number to call type, used in the report.

To display the Reports section, click the name of the report from the basic mode homepage or from the View Reports page accessed from the tools page. The View Report page displays.

Note the Tools page can only be accessed by users who have been granted Advanced Mode status. See the User Settings section.

To edit a report:
1. Click the name of the report in your homepage. The View Reports page displays.
2. Click Edit. The Edit Report Details page displays.
3. In the Name field enter a new name for the report.
4. In the Sub Title field enter a simple question which reflects the report contents and which is used as the displayed title for the report, such as ‘How many calls are queued?’
5. In the Description field enter any explanatory text, if required.
6. Click **Enabled** checkbox to ensure that the report is available to system users.
7. Click **Hidden** checkbox to prevent users from accessing it.
8. Click **Save** to apply the new parameters.

In the Toolbar, the following options are available:
- **Thresholds** for further information about applying threshold values to report data, see the Set Report Exception Thresholds section.
- **Move** click to display the report tree and select a folder to relocate the report to.
  For further information see the Manage Reports section.

### Setting Report Exception Thresholds

Reports may contain many hundreds, even thousands of rows. Most of the data displayed in those rows reflects normal operational conditions and would fall within acceptable limits. Exception thresholds enable you to set conditions on the data displayed in the report. Any data value which fails those conditions can be highlighted, enabling you to quickly identify areas of poor performance.

#### Creating or Editing a Report Exception Threshold

To create or edit a report exception threshold:
1. Click the name of the report in your homepage.
2. Click **Thresholds**. The Set Threshold page displays.
3. Select a threshold to edit. Then perform the following:
   - In the **Name** field enter the name to identify the threshold value
   - From the **Relation** drop-down list, select one of the following:
     a.  = (equals)
     b. <>(does not equal)
     c.  IIN (If In)
     Then enter the value in the field provided.
     If however, you selected the IIN option, two value fields displays. Enter the lowest and highest value, or a comma-separated list of values to match.
   - Select the Back color, Font color and Font size from the relevant drop-down lists. Then select the radio buttons of the font attributes; Bold, Italic or Underlined.
4. Click **OK**.
5. System Manager

Managing the System

Page Access and Use

Use the Systems Manager tool page to create resource folders and resources.

To display the System Manager section, click Tools > System Manager and the System Manager tools page displays.

Tip Alternatively, if you use the System Manager tool regularly you may wish to make it your default page. To do this:

1. Click Settings and the Settings page displays.
2. Click User Settings.
3. Select System Manager from the Default Homepage drop-down list.
4. Click OK.
5. Click Home. The System Manager displays as your homepage.

Note the Tools page can only be accessed by users who have been granted Advanced Mode status. See the User Settings section.

Using Unified CCMP with Other Provisioning Systems

Unified CCMP can be used alongside other provisioning systems, such as the Hosted Unified Communication System (HUCS) and Cisco Unified Provisioning Manager (CUPM), but must not be used to provision resources normally provisioned by the alternate system, as these resources may be deleted.

What are Resources?

Resources are the entities in the system which display as data in reports. Each tenant in the system has resources assigned to them, such as dialed numbers, agents and so on. These resources are used on a daily basis as a part of contact center network operations. Reports show you how these resources are used. However it is important to differentiate between the types of resources used by the system. There are two different types:

- **System Items** (users, folders and so on) are entities which can be created and managed in the system.

- **Resource Items** (agents, dialed numbers and so on).
Creating and Managing System Items

The system items you can create and manage are:

<table>
<thead>
<tr>
<th>System Items</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code Group</td>
<td>This item is not required or used by Unified CCMP.</td>
</tr>
<tr>
<td>Dashboard</td>
<td>This item is not required or used by Unified CCMP.</td>
</tr>
<tr>
<td>Dashboard Layout</td>
<td>This item is not required or used by Unified CCMP.</td>
</tr>
<tr>
<td>Folder</td>
<td>The placeholders in the system for related information. For further information see the Managing Folders section, on page 88.</td>
</tr>
<tr>
<td>Group</td>
<td>The contact center team members who are permitted to access Unified CCMP. For further information see the Managing Groups section, on page 90.</td>
</tr>
<tr>
<td>Information Notice</td>
<td>The means of displaying information to all users. For further information see the Managing Information Notices section, on page 21.</td>
</tr>
<tr>
<td>Report Parameter Set</td>
<td>The means by which contact center data is organized and displayed. For further information see the Managing Reports section, on page 28.</td>
</tr>
<tr>
<td>Report Data Source</td>
<td>This item is not required or used by Unified CCMP.</td>
</tr>
<tr>
<td>Report Style Sheet</td>
<td>This item is not required or used by Unified CCMP.</td>
</tr>
<tr>
<td>User</td>
<td>The contact center members who are permitted to access Unified CCMP. For further information see the Managing Users section, on page 90.</td>
</tr>
</tbody>
</table>

Creating and Managing Resource Items

The resource items you can create and manage are:

<table>
<thead>
<tr>
<th>Resource Items</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Person</td>
<td>The representation of a physical person on the system. A person can be a user and/or one or more agents. For further information see the Managing Persons section.</td>
</tr>
<tr>
<td>Agent</td>
<td>A person who handles customer contacts. For further information see the Managing Agents section.</td>
</tr>
<tr>
<td>Agent Desktop</td>
<td>A set of permissions or settings for a particular agent, such as how much time is allocated to wrap-up and what outbound calls can be made. For further information see the Managing Agent Desktops section.</td>
</tr>
<tr>
<td>Agent Team</td>
<td>A group of agents, managed by one or more supervisors. For further information see the Managing Agent Teams section.</td>
</tr>
<tr>
<td>Skill Group</td>
<td>A collection of agents with the same skills and assigned to a single media routing domain. For further information see the Managing Skill Groups section.</td>
</tr>
<tr>
<td>Resource Items</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Enterprise Skill</td>
<td>Logical grouping of skill groups. These may be from different media routing domains. For further information see the Managing Enterprise Skill Groups on page 64.</td>
</tr>
<tr>
<td>Group</td>
<td></td>
</tr>
<tr>
<td>Call Type</td>
<td>Category of incoming routable task. The call type determines the routing script that is run for the call. For further information see the Managing Call Types on page 70.</td>
</tr>
<tr>
<td>Dialed Number</td>
<td>Number dialed by the caller. This helps to determine the call type. For further information see the Managing Dialed Numbers on page 68.</td>
</tr>
<tr>
<td>Label</td>
<td>String that is passed to a routing client for each network target. For further information see the Managing Labels on page 72.</td>
</tr>
<tr>
<td>IP Phone</td>
<td>IP device with a single line used by an agent to make and receive calls. For further information see the Managing IP Phones on page 73.</td>
</tr>
<tr>
<td>Directory Number</td>
<td>Line connected to an IP Phone. For further information see the Managing Directory Numbers on page 75.</td>
</tr>
<tr>
<td>Device Profile</td>
<td>Profile of a user from Unified CM which will be applied to the phone to which they login. For further information see page 77.</td>
</tr>
<tr>
<td>User Variable</td>
<td>Named object that holds a value - often used in routing scripts. For further information see the Managing User Variables on page 81.</td>
</tr>
<tr>
<td>VRU Script</td>
<td>Script used by the voice response unit to play a message at the caller. For further information see the Managing VRU Scripts on page 79.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> you cannot provision a VRU Script through the Management Portal; you may only change its associated audio file.</td>
</tr>
</tbody>
</table>

**Note** you may also view the details of items provisioned through Unified CCE, such as Media Routing Domain or Script, but you will not be able to edit these.

**Note** a resource can be successfully provisioned in Unified CCMP even if it cannot be provisioned within Unified CCE. In this case it will remain in the Pending Active state.

**What is the System Manager tool?**

The System Manager tool allows you to partition your resources in a hierarchical structure. This is achieved by the use of a folder tree located at the left hand side of the tool. The user may view the subfolders of specific folders by selecting them. Users with sufficient security privileges can access and manage the entire contents of the system via the System Manager interface. The Web Administration Portal lets you remotely configure and administer key aspects of your Unified CCE system including:

- Agents, agent teams, skill groups and desktop settings
- Dialed numbers and call types

**Note** You cannot manage security in the System Manager. See the Manage Security section for details of how to manage security in the Management Portal.

The System Manager tool consists of the following panels:

- **Standard toolbar, breadcrumb trail** (displays the path by which the user accessed the current page) and **Information Management panels** are displayed at the top of the browser.

- **Folder Tree** panel displays on the left of the browser. The folder structure partitions all the resources the user is allowed to see based on their security rights (for further information see the Tree Structures section). Selecting a folder allows you to see its contents in the Items panel. There is a minimize arrow located on the right edge of this panel to give the user more screen space if the folder tree is not required.

- **Items** panel displays in the middle of the browser. The Items panel shows the items contained in the currently selected folder. Selecting a type of resource displays a list of items of that resource type in the currently selected folder. Selecting a particular item allows you to see its contents in the Details panel. There is a minimize arrow located on the right edge of this panel to give the user more screen space if the resource items list is not required.

  **Note** not all of the item types displayed can be provisioned or edited through Unified CCMP.

- **Details** panel displays on the right hand side of the browser. This panel displays the details of the resource item currently selected in the Items panel. If you have sufficient security permissions, you may be able to edit these.

**Anchoring Resources**

If you select a tab in the right-hand **Details** panel, then when the selected item is changed in the center Items panel the view is anchored by the Details panel so that the same tab displays for the new item.

The reverse is also true: if you select an associated resource that displays in the Details panel (for example, a skill group would be an associated resource shown for an Agent), the type of resources shown in the Items panel will also change.

**Tree Structures**

The tree structure is organized into folders and tenant folders, which contain all the information relevant to reporting; the resources (such as dialed numbers) whose data is used in reports, the customers who own those resources and system security; the system users and user groups who provide customer service, their assigned user or group rights, called roles, and the system functions, or tasks which comprise them.

**Organizing the Tree Contents**

All the information relevant to the system is organized into tenant and resource folders. Each customer in the system is represented by a unique tenant folder and each system resource (dialed numbers, IVR scripts, and so on) owned by that customer are contained in related resource folders.
System security is based on the permissions that users have on these folders and the items within them. Security roles define how the user may access the customer and resource information in the system (a user may not even be permitted to see information that is not relevant to them), for example you may be allowed to run a report, but not change or delete it. More information on security is available in the Security Management section.

**Navigating the Folder Tree**

Tree structures can be expanded and contracted using the + (plus) and - (minus) icons displayed next to a folder. Folders are organized into a parent and child structure. Any folder with the + icon displayed next to it is a parent folder, which contains related subfolders or child folders. Click + icon to expand the tree and display the list of child folders contained in the parent folder. Similarly, click the - icon to collapse the tree and hide child folders.

**Managing the Tree**

The tree contains the entire contents of the system, but will only display the folders and tenants that are relevant to you as defined by your security (login) credentials.

**Resource Folder Tree Panel**

**Panel Access and Use**

This panel displays at the left of the browser and shows the user of the System Management tool the hierarchical partitioning structure typically setup by the tenant administrator. The user may select one folder at a time and view the items inside. The folder tree can be minimized using the arrow at the right of the panel.

**What is a Resource Folder?**

Users, customers and resources are contained in folders, which are organized into a tree hierarchy. The tree is organized into a standard, familiar structure with the root folder at the top of the tree; this is usually the service provider. Beneath the root folder, customers, their resources and the users who can access them are organized into parent/child folders. Folder management is accessed via the System Manager section. Each customer in the system is represented by a unique tenant folder and each system resource (dialed numbers, agent teams and so on) owned by that customer are contained in related resource folders.

**Note** it is possible to have many layers of resource folders.

There are several folder types:

- **Unallocated** system folder. This is a single system folder that contains all the resources that are not allocated to a tenant or shared across all tenants. It may only be accessed by the host Administrator.

- **Shared** system folder. This is a single system folder that contains resources that may be shared across tenants. It may only be accessed by the host Administrator.

- **Tenant** folder. There is one folder per tenant recorded in the system and each is normally created by the host Administrator.
Creating a Resource Folder

To create a folder:
1. Select the position in the folder tree where you wish the new folder to be added (for example, the tree root folder or within a customer folder).
2. In Items panel, select New ▼ > System Item > Folder. The Create a new Folder page displays.
3. Alternatively, click Tools. The Tools page displays. Click Create a Folder. The Create a new folder page displays.
   
   **Caution** it is not possible to modify a folder once it has been created, therefore choose the information to be entered into the following fields with care:
   - **Name** field enter a name for the new folder.
   - **Description** field enter any explanatory text for the folder, if required.
   - Uncheck the **Inherit Permissions** box to turn this folder into a policy root that does not inherit security permissions from its parent folder.
4. Click Save to save the new folder in the tree.
5. Select Create Another checkbox if you wish to create further folders to be placed into the tree structure at the same level.
   
   **Note** a folder inherits the security properties of the parent folder. Tenant folders stand alone and do not inherit any security permissions from a parent folder.

Creating Bulk Folders

In addition to creating folders one at a time, you can also bulk load folders previously output to a CSV (comma separated values) file. In this version bulk folder upload is only available to users assigned the “Manage Site” task. This is because security checks are not performed on the actions resulting from the upload. See the Bulk Upload section for further information.

Deleting a Resource Folder

To delete a folder:
1. Move all the resources in the folder and child folders to a different folder, or delete them.
2. In the Resource Items list panel, select the checkbox of the folder to be deleted.
3. Click Delete. The folder and its subfolders will be removed from the tree.

Moving a Resource Folder

To move a folder:
1. In the Items panel, select the checkbox of the folder to be moved.
2. Click Move. The Move the current items page displays, showing the folder tree.
3. Select the folder location in the tree that you wish to move the selected folder to.
4. Click OK.
Items Panel

Panel Access and Use

The Items panel is designed to show the items contained in the folder selected in the Folder Tree panel. It has its own toolbar containing New, Upload, Move and Delete buttons that represent operations that can be performed within that selected folder. From the displayed list, you can perform various actions on the item, such as edit, move or copy. *The actions that can be performed depend upon the item selected.*

List Resource Items

To list resource items:

1. From the left hand Folder Tree panel select a folder using a left mouse click. A list of summary totals of the resources available in this folder displays.
2. In the Items panel, click the type of resource you wish to view.

**Note** you can return from viewing a particular item type to viewing the summary list of resources by clicking on the folder in the left hand Folder Tree panel again.

**Note** the paging of the resources is an essential feature since the folder may contain many thousands of items. *An attempt to list too many items can cause the browser to crash.*

**Tip** the list of paged resource items may further be refined by using the Find facility. If the user enters text into the Find box and clicks Find, then the returned list shows only those resources that contain that text.

By default items are identified by their user-entered names, but the icon located next to the search box allows you to toggle the view of unique Enterprise Names of items instead.

Selecting a Resource Item

Resource items are selected in two different ways for two different purposes.

- To select one or more resource items to move or delete, click the checkboxes to the left of the items. You can select or deselect the entire list by clicking on the checkbox above the list.
- To view or edit the properties of a single resource item, click the item located in the list. The properties will be shown in the Details panel.

Creating a Resource Item

To create a new resource item:

1. In the Items panel, hover your mouse pointer over the down arrow ▼ beside New. Select the correct category of item (choose between system items such as folders and groups, and resource items such as agents), and select the correct resource.
2. A new page displays. The contents of this page depend on the resource that is being created. Fill in the details and click OK to confirm or Back to cancel the operation.
3. The System Manager displays and the new resource item will appear in the resource item list.

**Tip** you can create a resource item of the same type as those you are currently viewing by simply clicking New.

**Moving Resource Item(s)**
To move a resource item(s):
1. In the resource items list select one or more resource entries checkboxes.
2. Click **Move** toolbar button and the right hand panel displays a confirmation window.
3. Click **OK** to initiate the move operation.

**Deleting Resource Items**
To delete a resource item(s):
1. In the resource items list select one or more resource entries checkboxes.
2. Click **Delete** toolbar button and a confirmation window displays.
3. Click **OK** to initiate the delete operation.

**Merging Resource Items**
Some item types allow merging. This means that multiple items of similar type located on different equipment may be combined into one single resource.

To merge resource item(s):
1. In the resource items list select one or more resource entries checkboxes.
2. Click **Merge** toolbar to navigate to a new page allowing you to define the merge behavior.

On the merge resource interface perform the following steps to combine your selected items:

1. Ensure the selected items are correct, adding any additional items from the data grid located on the right.
2. Remove any items from the selected items on the left of the page that must be merged.
3. Ensure that the nominated master record is correct which is the record where other items will be merged.
4. Click **Merge**.
5. Confirm that the changes are correct; select the **Clean-up old items** checkbox to remove any old items that are not mapped to other pieces of equipment.
6. Click **Confirm** to complete the change and return to System Manager.
Details Panel

Page Access and Use

Use the resource items page to enter or change the details and associations of the selected resource type, such as agent.

To create a new resource item from the Web Administration menu select System Manager > Resource Folder > Resource Item > New > <resource type>.

To edit an existing resource item from the Web Administration menu select System Manager > Resource Folder. Select the resource type from the list in the middle panel and then select the item to be updated by clicking on its name.

The user is presented with a tabbed window, each tab representing an operation to be performed.

Details Tab

The details tab is a form which contains a series of fields for information that belong to the resource, such as First Name in the case of an Agent. Each field may be either mandatory, optional or read-only (that is, Unified CCMP fills it in automatically). Each field has a help text item to guide the user on its use and an indication as to whether it is mandatory or not.

Associations Tab

Depending on the type of resource there may be one or more association tabs that allow the user to associate other resources with this resource. For example, if a skill group has been selected then there will be an Agents tab to allow the user to specify which agents are to be associated with this skill group.

Tip The associations are normally symmetrical in that they can modified from each "side" of the association, so for example to add an agent to a skill group you can either select the skill group and use its agents tab or select the agent and use its skill group tab.

Each association tab has two sub-panels, one above the other. The top sub-panel shows the resource items that are already associated with this resource; the bottom sub-panel shows the available resources that may be added. The contents of the available items sub-panel are filtered by the logged in user's security privileges and any other pertinent business rule. For example, if adding agents to a skill group then the sub-panel will only show those agents who are on the same peripheral as the skill group.

The user may move resource items between the top and bottom sub panels in order to get the required associations.

Advanced Tab

Depending on the type of resource there may also be an Advanced tab. This shows information that is normally set by the system but may be overridden by the user.
History Tab

The History tab shows audit information for the resource. Where an event involves another resource, for example adding an agent to a skill group, the resource is linked to in the description. If a drop-down arrow is shown beneath an event, you can click it for more information (such as the user who performed the event). A Request event indicates a change made using the Management Portal’s user interface; an Execution event indicates that the requested changes were successfully made on Unified CCE. Success or failure of the event is shown by a green tick or red cross.

If the audit history for a resource is long, you can use the Edit Filter link to show only certain events, such as unsuccessful change attempts.

Status Tab

The Status tab shows the current status of the resource and its related resources. This enables you to see whether any problem with a resource originates with that resource or with its related resources. For example, when creating an Agent, if it enters the Error state that might indicate a problem with provisioning the related Person.

Resource States

Each resource in Unified CCMP can be in one of five states that indicate its stage in the resource life cycle.

- **Pending Active**
- **Ready**
- **Error**
- **Delete Pending**
- **Delete Confirmed**

Pending Active

When a resource is successfully created or changed using the Management Portal’s web interface, its state is set to **Pending Active** (sometimes shortened to just Pending). This indicates that while it has been provisioned successfully within Unified CCMP, it has not yet been fully provisioned within Unified CCE. A resource can be deleted while it is in this state.

Note a resource can be successfully provisioned in Unified CCMP even if it cannot be provisioned within Unified CCE. In this case it will remain in the **Pending Active** state.

Ready

When a resource has been successfully provisioned within both Unified CCMP and Unified CCE its state will be set to **Ready**. A resource will normally remain in this state until it is deleted.
Error

Where Unified CCMP is unable to provision the resource on Unified CCE, it will enter the Error state. You can attempt to fix this either by editing the item, in which case its state will become Pending Active again, or you can delete it, in which case it will be set to Awaiting Deletion (also known as Delete Pending).

Deletion Pending

When you delete a resource through the web interface (or when Unified CCMP automatically deletes a resource that has reached its Active to date) it enters the Awaiting Deletion state, which means that it has been successfully marked as deleted within Unified CCMP but has not yet been deleted from Unified CCE.

Delete Confirmed

Once the resource has been successfully deleted from Unified CCE it enters the Deleted state. Resources are never actually deleted from the Management Portal, only set to the Deleted state, as their histories are kept for audit reporting purposes.

Uploading Resources

The Bulk Upload tool is used to import hundreds of resource items into the Unified CCMP platform. It is used to generate dimensions such as an Agent or a Skill-Group by filling in dimension attributes using the standard CSV format.

All CSV files require headers which dictate where each value goes. To facilitate this Unified CCMP uses CSV templates. There is a template for every dimension type; for example, one for Agents, one for Skill-Groups, and so forth.

Note templates do not inform you the value type allowed in the field, for example, numeric values.

Member Attributes

Member attributes such as Peripheral Member or Desk Setting Member can always be removed from the CSV file completely, this means the relationship will never be set in any row in the CSV file. Alternatively you can leave this field blank, so there will be no relationship for that particular row.

Editing CSV files

You can use Notepad, or any other text-based editor to edit CSV files. Excel also offers support for CSV files so you can edit these in a familiar environment whilst maintaining the integrity of the CSV format.

Note there are a few known issues with Excel and the CSV format. If you find the CSV is corrupt after editing it in Excel, edit the file in a standard text editor such as Notepad and check the file for missing commas.

Template Guide

This section documents every template and describes the purpose of the columns included in each template.
For further information about the Data Type column in the tables below see the Data Types Error! Bookmark not defined. Error! Reference source not found.

Global Template Column Names

The column names shown in the next table appear in every template file. The Column Name is the heading entry at the top of each column of the CSV file. Brief descriptions of the other columns that appear in these tables are as follows:

- **Data Type** See Data Types on page 44, for a description of the data types that can be entered.
- **Column Required?** This column states whether you can remove this column from the table.
- **Column Description** This column describes what this field is for and any special requirements.

Data Types

The following data types are used:

- **SNC** indicates Standard Naming Convention and is the same as the UI allows in the name fields on the provisioning pages. That is, alphanumeric characters, no exclamation mark or hyphens, and so on
- **BOOLEAN** indicates one of the following values:
  - TRUE
  - FALSE
  - Empty field. Leaving these fields empty defaults the field to FALSE.
- **Y/N** is similar to Boolean however it can only contain the values Y or N.
- **Date** format is the universal date format <Year>-<Month>-<Day> for example 2006-08-30.
- Any Data Type marked with a hyphen (-) means that there are no constraints on what you can put in the field (except for the constraints imposed by the native CSV format).

Incorrect Data Type Entry

It is essential that the values in the template are of a valid data type. If an incorrect data type has been entered an error will be produced.

For example, if an alphabetic data type has been used instead of a numeric one the following error displays:

```
System.invalidCastException: The Peripheral Number is not numeric
```
### Column Name | Data Type | Column Required? | Column Description
--- | --- | --- | ---
Path | Path | No | Describes where in the Tree the dimension will be created. If you wish to supply the path in the Bulk Upload screen, you must remove this column. **Note** If you leave the column present and do not set a value, it will attempt to upload into the Root directory, which is valid for items such as folders, but not for resources such as Agent or Skill Group. Removing the column allows you to control the path via the Bulk Upload control screen.
Name | SNC | Yes | The name of the dimension in the Portal. This must be unique and will never be provisioned. **Note** an entry is required in this field
Description | - | Yes | Describes the dimension being created. This never gets provisioned. **Note** this field can be left blank
Enterprise Name | SNC | Yes | The name for the dimension being created. This does get provisioned and cannot be omitted. **Note** if you leave this field blank an Enterprise name is generated for you.
Effective From | Date | No | The date from which the dimension is active from (default is today). **Note** an entry is required in this field if you do not delete the column, it must be in the format <Year>-<Month>-<Day>
Effective To | Date | No | The date from which the dimension is inactive (default is today). **Note** an entry is required in this field if you do not delete the column, it must be in the format <Year>-<Month>-<Day>

### Person Template

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Data Type</th>
<th>Column Required?</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td>SNC</td>
<td>Yes*</td>
<td>The first name of the person</td>
</tr>
<tr>
<td>Last Name</td>
<td>SNC</td>
<td>Yes*</td>
<td>The last name of the person</td>
</tr>
<tr>
<td>Login Name</td>
<td>SNC</td>
<td>Yes*</td>
<td>The peripheral login name for the person</td>
</tr>
<tr>
<td>Pass phrase</td>
<td>Password</td>
<td>Yes</td>
<td>The peripheral login password for the person</td>
</tr>
<tr>
<td>Equipment Name</td>
<td>Enterprise Name</td>
<td>Yes*</td>
<td>The instance name of the CCE/CM you want this person added to. This will correspond directly with the instance name for the CCE/CM specified when configured using the Unified CCMP Configuration Manager.</td>
</tr>
</tbody>
</table>

**Note.** When uploading Person records to a location when both Unified CCE and Unified CM resources exist, the Person will be attached to both pieces of equipment unless the equipment field is set in the bulk load template.
### Agent Template

For further information about the Data Type column in the table below, refer to **Data Types** section on page 44.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Data Type</th>
<th>Column Required?</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Peripheral Member</td>
<td>Enterprise Name</td>
<td>Yes</td>
<td>The Peripheral where the Agent is assigned. <strong>Note</strong> an entry is required in this field</td>
</tr>
<tr>
<td>Desk Setting Member</td>
<td>Enterprise Name</td>
<td>No</td>
<td>The Desktop this Agent will use. <strong>Note</strong> an entry is required in this field if you do not delete the column</td>
</tr>
<tr>
<td>Agent Team Member</td>
<td>Enterprise Name</td>
<td>No</td>
<td>The team where the Agent is assigned. The team must be on the same Peripheral otherwise provisioning will fail. This column may be subject to capacity limitations; for example, there may only be so many agents allowed in a team and that team has already reached its capacity. <strong>Note</strong> an entry is required in this field if you do not delete the column</td>
</tr>
<tr>
<td>Portal Login</td>
<td>-</td>
<td>No</td>
<td>This column is a placeholder for a pending feature. <strong>Note</strong> Remove it before uploading.</td>
</tr>
<tr>
<td>First Name</td>
<td>SNC</td>
<td>Yes</td>
<td>The first name of the agent. <strong>Note</strong> an entry is required in this field</td>
</tr>
<tr>
<td>Last Name</td>
<td>SNC</td>
<td>Yes</td>
<td>The last name of the agent. <strong>Note</strong> an entry is required in this field</td>
</tr>
<tr>
<td>Login Name</td>
<td>SNC</td>
<td>Yes</td>
<td>The peripheral login name for the agent. <strong>Note</strong> an entry is required in this field</td>
</tr>
<tr>
<td>Pass Phrase</td>
<td>Password</td>
<td>Yes</td>
<td>The peripheral login password for the agent. In this release the password length can be set to 0 (zero). If the password length is set to 0 the agent is not required to login to the peripheral. <strong>Note</strong> this field can be left blank</td>
</tr>
<tr>
<td>Supervisor</td>
<td>Boolean</td>
<td>No</td>
<td>Indicates whether the agent is a supervisor. This will not create a Portal user, and is a pending feature; however it enables you to bind this agent to a domain login name. <strong>Note</strong> an entry is not required in this field if you retain this column</td>
</tr>
<tr>
<td>Peripheral Number</td>
<td>Numeric</td>
<td>Yes</td>
<td>The service number as known at the peripheral, <strong>Note</strong> an entry is required in this field</td>
</tr>
<tr>
<td>Agent State Trace</td>
<td>Y/N</td>
<td>No</td>
<td>Indicates whether the software collects agent state trace data for the agent. <strong>Note</strong> an entry is not required in this field if you retain this column</td>
</tr>
<tr>
<td>Domain Login Name</td>
<td>NETBIOS Login Name</td>
<td>No - if Agent is not a supervisor</td>
<td>The login name for the domain user the agent is bound to. This is only relevant if the Supervisor field is set to TRUE. Example: DOMAIN\USERNAME</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------------</td>
<td>----------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Domain User Name</td>
<td>NETBIOS Username</td>
<td>No - if Agent is not a supervisor</td>
<td>The username of the domain user; therefore the Login-name: DOMAIN\USERNAME, the Username is simply USERNAME</td>
</tr>
</tbody>
</table>

**Folders Template**

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Data Type</th>
<th>Column Required?</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security</td>
<td>CSS Styled List</td>
<td>No</td>
<td>Allows you to set security on the folder you upload, an example is shown below</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Note</strong> an entry is not required in this field if you retain this column</td>
</tr>
</tbody>
</table>

**Agent Security Field Example**

The following is a Dos-styled syntax example:

```plaintext
<USERORGROUPNAME>:<ROLENAME>;<USERORGROUPNAME>:<ROLENAME>[:<MULTIPLEROLENAMES>]
```

This is an example of what can be entered in the **Security** field in the agent CSV file.

// #1 a single user with a single role
Administrator:Tenant User

// #2 a single user with more than one role
Administrator:Tenant User:Tenant Supervisor

// #3 multiple users
Administrator:Tenant User:Tenant Supervisor;User1:Tenant User

Users are separated by semicolons, and the user and roles are separated by colons. This is very similar to the CSS syntax with the exception that a user or group can have multiple roles rather than one value.

**Agent Desktop Template**

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Data Type</th>
<th>Column Required?</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wrap up Incoming Mode</td>
<td>Numeric</td>
<td>Yes</td>
<td>Indicates whether the agent is allowed or required to enter wrap-up data after an inbound call.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0= Required</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1 = Optional</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2= Not allowed</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Note</strong> an entry is required in this field</td>
</tr>
<tr>
<td>Column Name</td>
<td>Data Type</td>
<td>Column Required?</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------</td>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Wrap up Outgoing Mode    | Numeric   | Yes              | Indicates whether the agent is allowed or required to enter wrap-up data after an outbound call.  
|                          |           |                  | 0= Required  
|                          |           |                  | 1 = Optional  
|                          |           |                  | 2= Not allowed  
|                          |           |                  | **Note** an entry is required in this field                                 |
| Wrap-up Time             | Numeric   | Yes              | The amount of time in seconds (1-7200) allocated to an agent to wrap up the call  
|                          |           |                  | **Note** an entry is required in this field                                 |
| Remote Agent Type        | Numeric   | Yes              | Even though this field is mandatory, it is only used in Unified CCE Release 7.2 or later, see Unified CCE documentation for more details.  
|                          |           |                  | **Note** an entry is required in this field                                 |

**Agent Team Template**

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Data Type</th>
<th>Column Required?</th>
<th>Description</th>
</tr>
</thead>
</table>
| Peripheral Member        | Enterprise Name| Yes              | Same as Agent Peripheral Member.  
|                          |               |                  | **Note** an entry is required in this field                                 |
| Dialed Number Member     | Enterprise Name| No               | The dialed number to use for this Agent team.  
|                          |               |                  | **Note** an entry is not required in this field if you retain this column    |

**Enterprise Skill Group Template**

This template does not contain any dimension-specific columns.
## Skill Group Template

For further information about the Data Type column in the table below, refer to Data Types section on page 44.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Data Type</th>
<th>Column Required?</th>
<th>Description</th>
</tr>
</thead>
</table>
| Peripheral Member Name | Enterprise Name | Yes              | Same as Agent Peripheral Member.  
Note an entry is required in this field |
| Peripheral Number      | Numeric      | Yes              | Same as Agent Peripheral Number.  
Note an entry is required in this field |
| Peripheral Name        | SNC          | No               | The name of the Peripheral as it is known on the site.  
Note an entry is required in this field if you retain this column |
| Available Hold-Off Delay | Numeric    | No               | The value for this Skill Group instead of using the one associated with this peripheral.  
Note an entry is not required in this field if you retain this column |
| IPTA                   | Y/N          | No               | Indicates whether Unified CCE picks the agent.  
Note an entry is not required in this field if you retain this column |
| Service Level Threshold | Numeric     | No               | The service level threshold, in seconds, for the service level. If this field is negative, the value of the Service Level Threshold field in the Peripheral table is used.  
Note an entry is not required in this field if you retain this column |
| Service Level Type     | Numeric      | No               | For Non-Unified CCE, indicates how the Unified CCE software calculates the service level for the service. See the Unified CCE documentation to determine value meanings.  
Valid Values are 0, 1, 2 or 3.  
Note an entry is not required in this field if you retain this column |
| Default Entry          | Numeric      | No               | Normal entries are 0 (zero). Any records with a value greater than 0 are considered a default skill group for configuration purposes. Records having a value of 1 are used by OPC as the default target skill group.  
Note an entry is not required in this field if you retain this column |
| Extension              | Numeric      | Yes              | The extension number for the service (used by Lucent DEFINITY ECS).  
Note an entry is required in this field |

## User Variable Template

This template does not contain any dimension-specific columns.
Using the Bulk Upload Tool

To use the Bulk Upload tool, perform the following:

1. Open the **System Management** page.
2. Select the required tenant.
3. Click **Upload** and then select the item types you want to bulk upload from the drop-down list. The Bulk Upload Control page displays.
   - **Note** This path will only be used if you have removed the **Path** column in the CSV file. This is not relevant for folders as the path option is not available.
4. Select a template for your chosen dimension. The template link is present in the horizontal toolbar near the top of the page. Once selected, a download box displays allowing you to save this CSV file to your machine.
5. Save the file. Once saved you can open it in the editor you require and begin to enter your data or paste it from another source.
6. Return to the **Bulk Upload Control** page and make sure the path is set correctly.
7. Browse to the CSV file you have just entered the data into.
8. Click **Upload**. A progress bar at the bottom of the screen displays the upload progress.

   **Note** Do NOT upload more than 500 items per CSV file.

If an error occurs, pause the upload and check why an item failed. For further information about how an upload can fail, please see the **Reasons for Upload Failure** later in this document.

If the upload tool encounters a problem that affects all rows and not just the current one, an alert box appears that describes the problem and returns you back to the **Bulk Upload Control** page.

Once every row has been processed a summary window appears to inform you of how many rows failed and how many passed.

**Note** this window does not give you the result of provisioning these items; it only provides the result of uploading the items into the Unified CCMP system.

### Reasons for Upload Failure

The table below details the causes as to why an upload can fail.

<table>
<thead>
<tr>
<th>Exception Type</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Capacity Left</td>
<td>The capacity limit has been reached.</td>
</tr>
<tr>
<td>Enterprise Name Already Exists</td>
<td>The enterprise name already exists.</td>
</tr>
<tr>
<td>Login Name Already Exists</td>
<td>The peripheral login name already exists.</td>
</tr>
<tr>
<td>SQL Exception</td>
<td>The SQL error during upload, usually due to bad data.</td>
</tr>
<tr>
<td>Argument Exception</td>
<td>An attribute contains a bad value. It is usually an exception because</td>
</tr>
<tr>
<td></td>
<td>you have an empty string in the <strong>Path</strong> column when attempting to</td>
</tr>
<tr>
<td></td>
<td>upload items which cannot live in the <strong>Root</strong> folder.</td>
</tr>
<tr>
<td>Security Exception</td>
<td>You do not have security permissions to upload to here.</td>
</tr>
<tr>
<td>Format Exception</td>
<td>Invalid data in a column.</td>
</tr>
<tr>
<td>No Identity Available</td>
<td>Identity not available.</td>
</tr>
</tbody>
</table>
Agent Management

Managing Persons

Page Access and Use

Use the Persons page to create, edit, and delete individual persons, and to define their access to Unified CCMP (if any) and their associated agents. To open the page, from the Web Administration menu, select System Manager > Resource Folder > New ▼> Resource Item > Person.

What is a Person?

Each person item represents a single physical person who handles customer contacts or uses the Management Portal. This person may be associated with a user account on the Management Portal, with one or more Agents or Unified CM users.

Note to associate a person with more than one Agent, each Agent must be on a different peripheral.

Creating a Person

To create a person:

1. In the Items panel, click New ▼> Resource Item > Person.
2. Enter a first name, last name, login name and password for the person. They will use the details specified in the Login Name box to log on to their Agent Desktop. Names can be up to 24 characters long, and must consist of letters, numbers, underscores and periods only.
   
   Note the login name details cannot be edited once the agent has been created.
3. Complete fields as described in the Persons fields table below. Active from and to dates can be set in the Advanced tab.
4. If the person is to have a Portal account, fill in the fields in Unified CCMP tab.
5. Click Save.

Note once created, a Person’s Portal Account details cannot be edited via the agent. You must edit the user directly.

How to Bulk Create Persons

In addition to creating persons one at a time, you can also bulk load person records previously output to a CSV (comma separated values) file. See the Uploading Resources section for further information.

Changing a Person’s Peripheral Login

To change a person's peripheral login:

1. In the Equipment tab, check Change Password.
2. Enter a new password and confirm.
3. Click Save.
Deleting a Person

To delete one or more persons:

1. In the **Items** panel, select the person record(s) you want to delete.
2. Click **Delete**.
3. A message prompts you to confirm the deletion. Click **OK**.

All agents associated with those persons will also be deleted.

### Person Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Default Details Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>First Name</td>
<td>The person's first name.</td>
<td>Up to 24 characters.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Last Name</td>
<td>The person's last name.</td>
<td>Up to 24 characters.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the person.</td>
<td>Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Login Name</td>
<td>A unique login name for the person to allow them to login to the peripheral. This is the default entry that will be used for all equipment mappings unless overridden in the equipment tab. <strong>Note</strong>: The Unified CCE database is case-insensitive in determining whether a login name is unique - for example, it considers &quot;joe_smith&quot; and &quot;JOE_SMITH&quot; to be the same. Further, agent login to agent desktop software (such as CTI OS) is not case-sensitive. Unique. Up to 24 characters, letters, numbers, and underscore characters only. Must begin with letter or number.</td>
<td>Null</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Password</td>
<td>The default password used by equipment mappings unless explicitly set in the equipment tab</td>
<td>Ask your system administrator for details.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Password Confirmation</td>
<td></td>
<td></td>
<td>Null</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Note**: changes to the default details will only be reflected on equipment mappings that have not been customized.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Equipment Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unified ICM</td>
<td>A selection as to whether or not this person exists on Unified ICM</td>
<td>Checkbox, true or false</td>
<td>True</td>
<td>N/A</td>
</tr>
<tr>
<td>Unified ICM Equipment</td>
<td>The Unified ICMH instances to which this person record is assigned</td>
<td>The list of Unified ICM’s to which the person may be added. Check box list</td>
<td>False</td>
<td>N/A</td>
</tr>
<tr>
<td>Unified CM</td>
<td>A selection as to whether or not this person exists as a user on the associated Unified Communications Manager</td>
<td>Checkbox, true or false</td>
<td>False</td>
<td>N/A</td>
</tr>
<tr>
<td>Unified CM Equipment</td>
<td>The Unified CM from the cluster that this person is tied to</td>
<td>The list of Unified CMs to which the person may be added. Check box list</td>
<td>False</td>
<td>N/A</td>
</tr>
</tbody>
</table>

**Note**: the above mentioned equipment lists provide a mechanism for customizing the details on a per equipment basis.
### Field | Description | Entry | Default | Required?
--- | --- | --- | --- | ---
#### Portal Tab
Create Account | Check this box to create a basic Portal user account for this person. It is advantageous for supervisors to have a Portal account in order to manage their teams. | Checkbox | Unchecked | No
Login Name | The unique name of Unified CCMP user account. Unique. Up to 24 characters, letters, numbers, and underscore characters only. Must begin with letter or number. | Null | If Create Account checked | No
Password | The password that the person will use to log in to the system. Unique. At least five letters long. Longer passwords, including numbers and other characters, may be required. Ask your system administrator for details. | Null | If Create Account checked | No
Confirm Password | The same as for the Password field. This ensures that the person is not prevented from logging into Unified CCMP by typographical errors made when setting his or her password. | Null | If Create Account checked | No
Groups | Allows you to assign the user to one or more security groups, such as the Supervisors group. You can only assign a user to groups you have permission to modify. | Check the boxes of the security groups this user must be a member of. | Unchecked | No
#### Advanced Tab
Active From Date | The date from which the person will be active in the system. | Select from calendar. | Current date | Yes
Active To Date | The date after which the person must be deleted from the system. | Select from calendar. | Forever | No

### Managing Agents

#### Page Access and Use
Use the Agents page to create, edit, and delete agents and supervisor agents, and to define agent properties such as passwords, voice skill group associations, and desk settings. To open the page, from the Web Administration menu, select **System Manager > Resource Folder > New ▼> Resource Item > Agent**.

#### What is an Agent?
An agent is a person who handles customer contacts. In Unified CCE, each agent can be a member of one or more skill groups. You can group agents into agent teams, which associate each with a specific supervisor or supervisors.
Each agent record must be associated with a Person. During agent creation, you can choose either to associate the agent with an existing person, or to create a new person for that agent. Multiple agents can be associated with a single person, if required (for example, someone who provides cover for teams on different peripherals will need to be represented by a separate agent account on each peripheral used).

**Note** In order to use non-voice applications (that is, Cisco Unified Web and E-Mail Manager), agents must be enabled for non-voice use and assigned to non-voice skill groups via the administration interfaces for these multi-channel applications. Thus, while you can create all of your new agent records using the Management Portal, you will need to use the administration interfaces of these non-voice applications to configure agents for their use.

### Creating an Agent

To create an agent:

1. In the **Items** panel, click **New ▼ > Resource Item > Agent**
2. Enter a first name, and select a peripheral and Person to associate the agent with. You can choose either to associate the agent with an existing Person, or to create a new Person for that agent.
   - **Select Existing Person** Select a person from the drop-down list, or search for a specific person by typing a part of their name in the **Search** box. The new agent will use the details specified in that Person’s **Peripheral Login** box to log on to their Agent Desk Setting.
   - **Create New Person** Enter the first name and last (or family) name for the person, and fill in the details they will use to login to the peripheral. The person will be automatically created and associated with the agent.
     
     **Note** Multiple Agents may be associated with a single Person, if all Agents involved are on different peripherals.
3. Complete fields as described in the Agents fields table below. Active from and to dates can be set in the **Advanced** tab.
4. Click **Save**.

Once you've created an agent, you can assign that user as the member of an Agent Team, and to one or more Skill Groups

### What is a Supervisor Agent?

A supervisor agent is an agent who has a user account on Unified CCMP that allows them to view reports and administer agents and agent teams. While a supervisor agent does not have to be assigned to supervise a specific team, an agent must be a supervisor agent to supervise a team.

A team supervisor may be a **primary** or **secondary** supervisor. A team may have any number of secondary supervisors, but only one primary supervisor.

You can define an agent to be a supervisor agent by checking the **Supervisor** checkbox.

**Note** when an agent is set to be a supervisor agent, then if the associated Person has a Portal user account, that user must be added to the Supervisors security group, which allows users to edit agents and agent teams.
Adding an Agent to a Team

You can use the Agent Teams tab to change the team an agent is a member of and, in the case of a supervisor agent, to set the agent as primary or secondary supervisor for one or more teams.

Note A supervisor agent does not need to be a member of a team to supervise it.

To add an agent to a team as either a supervisor or a member:

1. In the Items panel, select the agent record you wish to add to one or (if a supervisor) more teams.
2. In the Details panel, click Agent Teams tab.

Shown in the upper box is a list of teams the agent is currently assigned to, and shown in the lower box is a list of teams available in the current folder. You may see teams in other folders using the Selected Path drop-down folder list. The dates between which each team is active are displayed, as is the primary supervisor for that team.

3. Select teams in the lower box and click Add to add the agent to them. They will automatically be moved into the upper box.
4. Check Member box if the agent is to be a member of the team. This box must be checked in most cases.

Note an agent cannot be a member of more than one team, though a supervisor can supervise multiple teams.

5. If the agent is a supervisor agent, you may choose to assign them as a supervisor to that team. Select Primary or Secondary supervisor from the drop-down list. A team can have multiple secondary supervisors but only one primary supervisor.

Note if you replace an existing primary supervisor, then the replaced supervisor will automatically become a secondary supervisor for that team.

6. You can remove the agent from a team by selecting the team (or teams) in the upper box and click Remove.

7. Click Save.
How to Bulk Create Agents

In addition to creating agents one at a time, you can also bulk load agent records previously output to a CSV (comma separated values) file. See the Uploading Resources section for further information.

Deleting an Agent

To delete one or more agents:

1. In the Items panel, select the agent record(s) you want to delete.
2. Click Delete.
3. A message prompts you to confirm the deletion. Click OK.

Note deleting an agent or agent supervisor will automatically remove that agent from any associated teams or skill groups, including multi-channel skill groups.

Note deleting an agent or agent supervisor does not delete the associated person.

Agent Example

ExampleCorp has ten agents in its New York contact center, and five in San Francisco. These agents are to be divided into three teams.

First, ExampleCorp creates two teams (Green and Blue) in New York, and one (Red) in San Francisco. Then it creates five Persons in San Francisco and ten Persons in New York, creates an Agent associated with each, and adds each Agent to a team.

ExampleCorp wants the two teams in New York to be supervised by the same senior supervisor agent. ExampleCorp therefore edits this agent to make her into a supervisor agent, and adds her as a Primary Supervisor to both teams. An agent can only be a member of a single team, however, so this supervisor supervises the Blue Team without being a member of it.

The user account of the Person associated with this supervisor agent is added to the ExampleCorp_Supervisors user group.

A primary supervisor is also assigned to the Red Team.

ExampleCorp then assigns secondary supervisors. It decides that the senior supervisor agent in New York must also be a secondary supervisor of the Red Team in San Francisco. Since it is possible to have any number of secondary supervisors for each team, this does not prevent them assigning a San Francisco agent as secondary supervisor to this team as well.
## Agent Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Details Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>A unique name for the entry. This may be the same as the login name, last name or first name fields. Your company may specify a convention for this field (such as <code>&lt;first name&gt;_ &lt;last name&gt;</code>) to make it easier to identify agents.</td>
<td>Unique. Up to 24 characters, letters, numbers, and underscore characters only. Must begin with letter or number.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the agent.</td>
<td>Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Peripheral</td>
<td>The peripheral the agent must be created on. This will affect what teams and skill groups they may be associated with.</td>
<td>Select from list</td>
<td>Default peripheral</td>
<td>Yes</td>
</tr>
<tr>
<td>Create New Person</td>
<td>Select this option if the agent record is for a new employee, or one who has not previously existed as a Person within the Management Portal.</td>
<td>Radio button</td>
<td>Checked</td>
<td>If Select Existing Person unchecked</td>
</tr>
<tr>
<td>First Name</td>
<td>The person's first name.</td>
<td>Up to 24 characters.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Last Name</td>
<td>The person's last name.</td>
<td>Up to 24 characters.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Login Name</td>
<td>A unique login name for the person to allow them to login to the peripheral. <strong>Note:</strong> The Unified CCE database is case-insensitive in determining whether a login name is unique - for example, it considers &quot;joe_smith&quot; and &quot;JOE_SMITH&quot; to be the same. Further, agent login to agent desktop software (such as CTI OS) is not case-sensitive.</td>
<td>Unique. Up to 24 characters, letters, numbers, and underscore characters only. Must begin with letter or number.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Password</td>
<td>The password that the person will use to log in to the system. <strong>Note:</strong> Ask your system administrator for details.</td>
<td>Ask your system administrator for details.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Confirm Password</td>
<td>The same as for the Password field. This ensures that the person is not prevented from logging in by typographical errors made when setting his or her password.</td>
<td></td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Select Existing Person</td>
<td>This option is used where the correct person to be associated with this agent record already exists within the system, for example if the Person record for a new employee was created before it was clear which peripheral they would be using. Select the correct person from the drop-down list.</td>
<td>Select from list. Filter list of persons by typing part of the person's name into the search box.</td>
<td>Unchecked</td>
<td>If Create New Person checked</td>
</tr>
<tr>
<td><strong>Supervisor Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Supervisor</td>
<td>Check this box if an agent is to be considered a supervisor. This does not require that they supervise a team.</td>
<td>Checkbox</td>
<td>Unchecked</td>
<td>No</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required?</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------</td>
<td>----------------</td>
<td>----------------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td>Associate with Domain Account</td>
<td>Associates a supervisor agent with an existing domain login</td>
<td>Checkbox</td>
<td>Unchecked</td>
<td>If Supervisor box checked</td>
</tr>
<tr>
<td>Login Name</td>
<td>The existing domain login name to be used by the supervisor agent</td>
<td>Existing domain login name. Select from list of possibilities by typing part of the login name.</td>
<td>Null</td>
<td>If Supervisor box checked</td>
</tr>
<tr>
<td></td>
<td><strong>Agent Teams Tab</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Agent Teams</td>
<td>The supervisory team with which the agent is associated.</td>
<td>Select from list.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>Skill Groups Tab</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Skill Group</td>
<td>The voice skill group(s) of which the agent is a member. Changes to an agent's skill group membership take place immediately within the agent's current session. Note: Skill groups for non-voice media routing domains (such as e-mail or chat) do not display in the Unified CCE Web Configuration Tool. To enable an agent for non-voice and assign an agent to a non-voice skill group, you must do it through your multi-channel application administration tool. Note: You may not add an agent to a skill group if that skill group already has the maximum number of agents associated with it. This maximum number depends on the configuration of your installation of Unified CCE.</td>
<td>Click Add to select from list.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>Advanced Tab</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enterprise Name</td>
<td>The name used to identify the agent within the system</td>
<td>Unique. Up to 24 characters, letters, numbers, and underscore characters only. Must begin with letter or number.</td>
<td>Auto-generated from the first and last names</td>
<td>Yes</td>
</tr>
<tr>
<td>Agent ID</td>
<td>The internal extension number that can be used to call the agent.</td>
<td>Up to 24 numbers.</td>
<td>Auto-generated</td>
<td>Yes</td>
</tr>
<tr>
<td>Agent Desktop</td>
<td>The desktop settings to be associated with the agent.</td>
<td>Select from list.</td>
<td>None</td>
<td>No</td>
</tr>
<tr>
<td>State Trace</td>
<td>Enables the system to track the agent's state, such as Logged Off or Talking</td>
<td>Checkbox</td>
<td>Unchecked</td>
<td>No</td>
</tr>
</tbody>
</table>
### Managing Agent Desktops

#### Page Access and Use

Use the Desktops page to create, edit, and delete agent desktops (also sometimes called agent desk settings). To open the page, from the Web Administration menu, select **System Manager > Resource Folder > New ▼ > Resource Item > Agent Desktop**.

#### What is a Desktop?

Agent Desktops associate a set of permissions or characteristics with specific agents. The settings are comparable to Class of Service settings on a PBX or ACD. You assign desk settings to each agent via the agent record.

When you create a desktop definition, you specify the amount of non-active time after which an agent is automatically logged out, whether wrap up is required following incoming and outbound calls, the amount of time allocated for wrap up, and the method used for assist and emergency calls. You also specify settings for the Re-route on No Answer feature.

Unified CCE ships with a system default desktop. New agent records are automatically assigned this default unless you specify otherwise when creating an agent.

#### How to Create a Desktop

To create a Desktop record:

1. In the **Items** panel, click **New > Desktop**.
2. Enter unique name of up to 24 characters for the record. This name can use alphanumeric characters, periods, and underscores.
3. Complete fields as described in the Desktop Fields table below.
4. Click **Save**.

#### Deleting a Desktop

To delete one or more desktops:

1. In the **Items** panel, select the desktop record(s) you want to delete.

---

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Skill Group</td>
<td>Displays the name of the skill group that will be used for capturing reporting information for calls which are not routed using a UCCE routing script. For example, calls placed directly to an agent's extension.</td>
<td>None</td>
<td>Peripheral Default</td>
<td>N/A</td>
</tr>
<tr>
<td>Active From Date</td>
<td>The date from which the agent will be active in the system.</td>
<td>Select from calendar.</td>
<td>Current date</td>
<td>Yes</td>
</tr>
<tr>
<td>Active To Date</td>
<td>The date after which the agent must be deleted from the system.</td>
<td>Select from calendar.</td>
<td>Forever</td>
<td>No</td>
</tr>
</tbody>
</table>
**Note** you cannot delete a desktop if it is being referenced by an Agent record or if it is specified as the Default Desktop.

2. Click **Delete**. A message prompts you to confirm the deletion.

3. Click **OK**.

**How to Bulk Create Agent Desktops**

In addition to creating agent desktop one at a time, you can also bulk load agent desk setting records previously output to a CSV (comma separated values) file. See the Bulk Upload section for further information.

**Desktop Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Details Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>A unique name for the record.</td>
<td>Unique. Up to 24 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Ring no answer time</td>
<td>The maximum number of seconds Unified CCE will allow a call to ring at the agent's station before redirecting the call. This can be from 1 to 120 seconds.</td>
<td>1 to 120</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Ring no answer dialed number</td>
<td>Identifies the dialed number for a new re-route destination in the case of a ring no answer. The selection list consists of the dialed numbers configured for the system.</td>
<td>Select from list</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Logout non-activity time</td>
<td>The number of seconds during which the agent has been in the not ready state and inactive that Unified CCE will wait before logging out the agent. A blank entry will disable the timer.</td>
<td>10 to 7200</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Incoming work mode</td>
<td>Indicates whether the agent is allowed or required to enter work mode after an incoming call.</td>
<td>Select from Required, Optional, Not Allowed, and Required With Wrap-up Data.</td>
<td>Optional</td>
<td>Yes</td>
</tr>
<tr>
<td>Outgoing work mode</td>
<td>Indicates whether the agent is allowed or required to enter work mode after an outgoing call.</td>
<td>Select from Required, Optional, and Not Allowed.</td>
<td>Optional</td>
<td>Yes</td>
</tr>
<tr>
<td>Wrap-up time</td>
<td>The amount of time in seconds allocated to an agent to wrap up the call.</td>
<td>1 to 7200</td>
<td>7200</td>
<td>Yes</td>
</tr>
<tr>
<td>Assist call method</td>
<td>Indicates whether Unified CCE will create a consultative call or a blind conference call for the supervisor assistance request.</td>
<td>Select from consultative call or blind conference call.</td>
<td>Consult</td>
<td>No</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required?</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>---------------</td>
<td>-----------</td>
</tr>
<tr>
<td>Emergency call method</td>
<td>Indicates whether Unified CCE will create a consultative call or a blind conference call for an emergency call request.</td>
<td>Select from consultative call or blind conference call.</td>
<td>Consult</td>
<td>No</td>
</tr>
<tr>
<td>Default Device Port Address</td>
<td>Changes the default port for the agent telephone.</td>
<td>Unique. Up to 24 characters, letters, numbers, and underscore characters only. Must begin with letter or number.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>* Quality Recording Rate</td>
<td>How frequently calls to the agent are recorded, in seconds.</td>
<td>1-99999</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>* Recording Mode</td>
<td>Specifies whether calls are routed through the Unified Communications Manager Peripheral Interface Manager (PIM)</td>
<td>Select from list</td>
<td>Bypass</td>
<td>No</td>
</tr>
<tr>
<td>Remote Agent Type</td>
<td>Indicates how mobile agent call routing is handled.</td>
<td>Select from list</td>
<td>Local Only</td>
<td>Yes</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the desktop.</td>
<td>Up to 500 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
</tbody>
</table>

**Miscellaneous**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto answer</td>
<td>Indicates calls to the agent are automatically answered.</td>
<td>Checked or Unchecked</td>
<td>Unchecked</td>
<td>No</td>
</tr>
<tr>
<td>Idle reason required</td>
<td>Indicates the agent must enter a Not Ready reason before entering the Idle state.</td>
<td>Checked or Unchecked</td>
<td>Unchecked</td>
<td>No</td>
</tr>
<tr>
<td>Logout reason required</td>
<td>Indicates the agent must enter a reason before logging out.</td>
<td>Checked or Unchecked</td>
<td>Unchecked</td>
<td>No</td>
</tr>
<tr>
<td>Auto record on emergency</td>
<td>Specifies that a record request (a request to record the call) is automatically sent when an emergency call request starts.</td>
<td>Checked or Unchecked</td>
<td>Unchecked</td>
<td>No</td>
</tr>
<tr>
<td>* Silent Monitor Audible Indication</td>
<td>Specifies whether to indicate that silent monitoring has begun by a click.</td>
<td>Checked or Unchecked</td>
<td>Unchecked</td>
<td>No</td>
</tr>
<tr>
<td>* Silent Monitor Warning Message</td>
<td>Specifies whether to indicate that silent monitoring has begun with a message box on the agent's desktop.</td>
<td>Checked or Unchecked</td>
<td>Unchecked</td>
<td>No</td>
</tr>
<tr>
<td>* Available after Incoming</td>
<td>Whether the agent is to be automatically considered available after handling an incoming call.</td>
<td>Checked or Unchecked</td>
<td>Unchecked</td>
<td>No</td>
</tr>
<tr>
<td>* Available after Outgoing</td>
<td>Whether the agent is to be automatically considered available after handling an outgoing call.</td>
<td>Checked or Unchecked</td>
<td>Unchecked</td>
<td>No</td>
</tr>
<tr>
<td>* Remote Login Without Desktop</td>
<td>Allows the agent to log in to the contact center without using an agent desktop</td>
<td>Checked or Unchecked</td>
<td>Unchecked</td>
<td>No</td>
</tr>
</tbody>
</table>

* Outbound Access
### Outbound Access
For deployments where agents can make outbound calls, determines the type of outbound calls they can make.

- Select one or more from International, National, Local private network, Operator assisted, PBX, Agent to Agent, Non ACD Calls, Initiate Supervisor Calls Allowed.
- Unchecked by default.
- Not required.

### Agent Tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry Details</th>
<th>Default</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agents</td>
<td>The agents with which the desktop is associated.</td>
<td>Select from list.</td>
<td>Null</td>
<td>No</td>
</tr>
</tbody>
</table>

### Advanced Tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry Details</th>
<th>Default</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enterprise Name</td>
<td>The name used to identify the desktop within the system.</td>
<td>Unique. Up to 24 characters, letters, numbers, and underscore characters only. Must begin with letter or number.</td>
<td>Auto-generated from the name</td>
<td>Yes</td>
</tr>
<tr>
<td>Active From Date</td>
<td>The date from which the desktop will be active within the system.</td>
<td>Select from calendar.</td>
<td>Current date</td>
<td>Yes</td>
</tr>
<tr>
<td>Active To Date</td>
<td>The date after which the desktop will be deleted from the system.</td>
<td>Uncheck Forever box and select from calendar.</td>
<td>Forever</td>
<td>No</td>
</tr>
</tbody>
</table>

### Managing Agent Teams

#### Page Access and Use
Use the Agent Teams page to create, edit, and delete agent teams, and to assign agents and supervisors to a team. To open the page, from the Web Administration menu, select System Manager > Resource Folder > New ▼ > Resource Item > Agent Team.

#### What is an Agent Team?
Unified CCE allows you to group individual agents into agent teams that can be managed by supervisors. Agents are assigned to agent teams individually. When configuring agent teams, be aware of the following rules:
- An agent can be a member of only one agent team (or of no teams)
- An agent team can have only one Primary Supervisor
- A supervisor can be a supervisor of any number of agent teams
- A supervisor for an agent team can also be a member of that agent team

#### How to Create an Agent Team
To create an agent team:
1. In the Items panel, click New ▼ Resource Item ▼ Agent Team.
2. Enter a unique name for the team.
3. Complete fields as described in the Agent Team Fields table below.
4. To assign agents to the team, check the boxes of one or more agents in the Agents tab, and click Add above the list.
   - Note the Selected Path drop-down list opens up a folder tree so that you can also select agents from other folders to add to the team.
5. Once an agent is added to the team, you must also check their Member box to make them a member of the team. This is because it is possible to be involved with a team without being a member, by supervising it.

6. If an agent is a supervisor, a drop-down list appears in the right-hand column. You can use this to specify whether the agent has a supervisory role for this particular team. 

   Note a team may have multiple secondary supervisors, but only one primary supervisor. If you replace an existing primary supervisor, then the replaced supervisor will automatically become a secondary supervisor for that team.

7. Click Save.

**How to Bulk Create Agent Teams**

In addition to creating agent teams one at a time, you can also bulk load agent team records previously output to a CSV (comma separated values) file. See the Uploading Resources section for further information.

**Editing an Agent Team**

To edit an agent team, select the agent team in the Items panel. Click through the tabs and edit the fields you want to change.

To remove agents from a team, click Agents tab and check the boxes of the agents you wish to remove from the team. Click Remove.

**Deleting an Agent Team**

To delete one or more agent teams:

1. In the Items panel, select the agent team record(s) you want to delete.
2. Click Delete.
3. A message prompts you to confirm the deletion. Click OK.

**Agent Team Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Details Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>A unique name for the record.</td>
<td>Unique. Up to 24 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the team.</td>
<td>Up to 500 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Supervisor script dialed number</td>
<td>The dialed number identifier for the agent team.</td>
<td>Select from list.</td>
<td>None</td>
<td>No</td>
</tr>
<tr>
<td><strong>Agents Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Agents</td>
<td>Individual agents associated with this team.</td>
<td>Select from list.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td><strong>Advanced Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enterprise Name</td>
<td>The name that will represent the team within the network</td>
<td>Unique. Up to 24 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>From Name and Peripheral</td>
<td>Yes</td>
</tr>
<tr>
<td>Peripheral</td>
<td>The peripheral to associate with the team.</td>
<td>Select from list.</td>
<td>Default peripheral</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Managing Skill Groups

#### Page Access and Use

Use the Skill Groups page to create, edit, and delete voice skill groups, and to assign agents to these groups. To open the page, from the Web Administration menu, select System Manager > Resource Folder > New ▼ > Resource Item > Skill Group.

#### What is a Skill Group?

A skill group is a collection of agents that share a common set of skills. Unified CCE agents are assigned one or more skills by associating the agent with the desired skill groups.

**Note** you may not add an agent to a skill group if that skill group already has the maximum number of agents associated with it. This maximum number depends on the configuration of your installation of Unified CCE.

Each skill group is associated with a specific media routing domain such as voice, chat, or e-mail. In a multi-channel deployment (that is, an Unified CCE deployment that includes non-voice applications like Cisco Unified Web E-Mail Interaction Manager), when an agent logs in (via phone, or Cisco Unified Web E-Mail Interaction) the agent automatically logs into skill groups associated with that agent within the correct MRD. Then, as a task request for a specific MRD begins script execution, the Agent/IVR Controller considers only the skill groups associated with that specific MRD. This allows one script to be written to handle many MRDs.

**Note** Unified CCMP does not support "sub-skill groups" - skill groups defined as a subset of a parent group.

#### How to Create a Skill Group

To create a skill group:

1. In the Items panel, click New > Resource Item > Skill Group.
2. Enter a unique name for the group.
3. Complete fields as described in the Skill Groups Fields table below.
4. To assign agents to the team, check the boxes of one or more agents, and click Add above the list.
   **Note** the Selected Path drop-down list at the top allows you to select agents from other folders to add to the team.
5. Click OK.

#### Skill Groups Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active From Date</td>
<td>The date from which this team must be active within the network</td>
<td>Select from calendar</td>
<td>Current date</td>
<td>Yes</td>
</tr>
<tr>
<td>Active To Date</td>
<td>The date after which this team will be deleted from the system</td>
<td>Uncheck Forever and select from calendar</td>
<td>Forever</td>
<td>No</td>
</tr>
</tbody>
</table>
How to Bulk Create Skill Groups
In addition to creating skill groups one at a time, you can also bulk load skill group records previously output to a CSV (comma separated values) file. See the Uploading Resources section for further information.

Editing a Skill Group
To edit a skill group, select the skill group in the Items panel. Click through the tabs and edit the fields you want to change.

To remove agents from a skill group, click Agents tab and check the boxes of the agents you wish to remove from the team. Click Remove.

Deleting a Skill Group
To delete one or more skill groups:
1. In the Items panel, select the skill group record(s) you want to delete.
   
   Note you cannot delete a skill group that is referenced in a script. This reference must be removed before the skill group can be deleted.

2. Click Delete.

3. A message prompts you to confirm the deletion. Click OK.

Note deleting a skill group automatically removes it from any enterprise skill groups in which it is referenced.

Skill Group Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Details Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>A unique enterprise name for the record.</td>
<td>Unique. Up to 24 characters, letters,</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>numbers, periods, and underscore characters only. Must begin with letter or number.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>A description of the skill group.</td>
<td>Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Service Level Type</td>
<td>Optionally, use to indicate how abandoned calls must be factored in</td>
<td>Select from Default, Ignore Abandoned</td>
<td>Default</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>calculating service levels.</td>
<td>Calls, Abandoned Calls Have Negative Impact,</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>and Abandoned Calls Have Positive Impact.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note: &quot;Default&quot; = Ignore Abandoned Calls.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Service Level Threshold</td>
<td>The threshold, in seconds, for the ICM service level.</td>
<td>1-99999</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>IPTA</td>
<td>Whether the ICM picks the agent.</td>
<td>Checkbox</td>
<td>Y</td>
<td>No</td>
</tr>
<tr>
<td>Media Routing Domain</td>
<td>The routing domain used for calls or emails to this skill group. This</td>
<td>Select from list.</td>
<td>Cisco_Voice</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>cannot be changed after skill group creation.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required?</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>---------</td>
<td>-----------</td>
</tr>
<tr>
<td><strong>Agents Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Agents</td>
<td>Agents associated with this skill group.</td>
<td>Select from list and click Add.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Default</td>
<td>Allows the skill group to act as the default skill group for the nominated agent.</td>
<td>Checkbox. Select the Default checkbox next to the selected agent.</td>
<td>N</td>
<td>No</td>
</tr>
<tr>
<td><strong>Advanced Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enterprise Name</td>
<td>The name that will represent the team within the network</td>
<td>Unique. Up to 24 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>From Name and Peripheral</td>
<td>Yes</td>
</tr>
<tr>
<td>Peripheral</td>
<td>The peripheral to associate with the skill group</td>
<td>Select from list.</td>
<td>Default peripheral</td>
<td>No</td>
</tr>
<tr>
<td>Peripheral Number</td>
<td>The number to be used on the peripheral for the Skill Group</td>
<td>0-999999999999</td>
<td>Generated automatically</td>
<td>Yes</td>
</tr>
<tr>
<td>Active From Date</td>
<td>The date from which the Skill Group must be active in the system</td>
<td>Select from calendar.</td>
<td>Current date</td>
<td>Yes</td>
</tr>
<tr>
<td>Active To Date</td>
<td>The date after which the Skill Group must be deleted from the system</td>
<td>Uncheck Forever and select from calendar.</td>
<td>Forever</td>
<td>No</td>
</tr>
</tbody>
</table>

**Managing Enterprise Skill Groups**

**Page Access and Use**

Use the Enterprise Skill Groups page to create, edit, and delete enterprise skill groups. To open the page, from the Web Administration menu, select System Manager > Resource Folder > New ➪ Resource Item > Enterprise Skill Group.

**What is an Enterprise Skill Group?**

An Enterprise Skill Group is a logical grouping of skill groups joined together for reporting purposes. Enterprise skill groups can include skill groups from different media routing domains.

**Note** unlike the Skill Groups page in Unified CCE Web Administration that displays only voice skill groups, the Enterprise Skill Groups page displays non-voice skill groups such as chat, multi-session chat, and email.

**Creating an Enterprise Skill Group**

To create an enterprise skill group:

2. Enter a unique name for the group.
3. Complete fields as described in the Enterprise Skill Group Fields table below.
4. To assign skill groups to the group, click Add below the Skill Groups box and select one or more skill groups.
Note the Selected Path drop-down at the top allows you to select agents from other folders to add to the team.

5. Click Save.

**How to Bulk Create Enterprise Skill groups**

In addition to creating enterprise skill groups one at a time, you can also bulk load enterprise skill group records previously output to a CSV (comma separated values) file. See the Uploading Resources section for further information.

**Deleting an Enterprise Skill Group**

To delete one or more enterprise skill groups:

1. In the Items panel, select the enterprise skill group record(s) you want to delete.
2. Click Delete.
3. A message prompts you to confirm the deletion. Click OK.

**Enterprise Skill Group Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Details Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>A unique name for the record.</td>
<td>Unique. Up to 24 characters, letters, numbers, periods, and underscore characters only. Must begin with letter or number.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Description</td>
<td>A description of this enterprise skill group.</td>
<td>Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td><strong>Skill Groups Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Skill Groups</td>
<td>Skill groups associated with this enterprise skill group.</td>
<td>Select from list and click Add.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td><strong>Advanced Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enterprise Name</td>
<td>The name by which the Enterprise Skill Group will be known within the system.</td>
<td>Unique. Up to 24 characters, letters, numbers, periods, and underscore characters only. Must begin with letter or number.</td>
<td>Auto generates</td>
<td>No</td>
</tr>
<tr>
<td>Active From Date</td>
<td>The date from which the Enterprise Skill Group must be active in the system.</td>
<td>Select from calendar.</td>
<td>Current date</td>
<td>No</td>
</tr>
<tr>
<td>Active To Date</td>
<td>The date from which the Enterprise Skill Group must be deleted from the system.</td>
<td>Uncheck Forever then select from calendar.</td>
<td>Forever</td>
<td>No</td>
</tr>
</tbody>
</table>
Contact Management

Managing Dialed Numbers

Page Access and Use

Use the Dialed Numbers page to create, edit, and delete dialed numbers and associate them with other resources such as Agent Desktops or Labels. To open the page, from the Web Administration menu, select System Manager > Resource Folder > New ▼ > Resource Item > Dialed Number.

Note it is not currently possible to associated Dialed Numbers with Call Types in Unified CCMP.

What is a Dialed Number?

A dialed number (DN) is the number a caller dials to initiate a call. It is sent as part of the call detail information in the route request message sent from the routing client. In Unified CCE, you set up a Dialed Number List, which identifies all of the phone numbers in your contact center that customers can dial to initiate contact. The Dialed Number plays an integral role in routing calls. Dialed Numbers are required pieces of call types, which are used to identify the appropriate routing script for each call. In addition to answered calls, Dialed Numbers also need to be set up for ring on no answer, dialed number plan entries, and for supervisor/emergency calls.

Creating a Dialed Number

To create a dialed number:

1. In the Items panel, click New > Dialed Number.
2. Enter unique name of up to 24 characters for the Dialed Number. This must consist of alphanumeric characters, periods, and underscores only.
3. Complete fields as described in the Dialed Number Fields table below.
4. Click Add to specify the call types and other dialing information to be associated with this dialed number.
   
   Note the order of the entries in the Dialed Number mapping table reflects the order in which call types are processed for the Dialed Number.
5. Click Save.

Deleting a Dialed Number

To delete one or more dialed numbers:

1. In the Items panel, select the Dialed Number record(s) you want to delete.
   
   Note you cannot delete a Dialed Number that is referenced in a script. This reference must be removed before the Dialed Number can be deleted.
2. Click Delete.
3. A message prompts you to confirm the deletion. Click OK.
## Dialed Number Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Details Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>A unique name for the record.</td>
<td>Unique. Up to 24 characters,</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>alphanumeric, period, and underscore</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>characters only. Must begin with</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>alphanumeric.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>A description of the record.</td>
<td>Up to 255 characters</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Dialed Number</td>
<td>For voice MRD only, the string value by which the Agent/IVR Controller</td>
<td>Up to 32 characters</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>identifies this Dialed Number. This must be the value</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>the Agent/IVR Controller uses for calls to this number. For example:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>8005551212</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Routing Client</td>
<td>The routing client (such as NIC or PG) that this number must use</td>
<td>Drop-down list</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Media Routing Domain</td>
<td>The media routing domain associated with this dialed number</td>
<td>0-99999999</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Permit Application</td>
<td>Whether this dialed number can be routed remotely by a CTI client</td>
<td>Checkbox</td>
<td>Unchecked</td>
<td>No</td>
</tr>
<tr>
<td>Outbound</td>
<td>Whether this dialed number must use an outbound Routing Client</td>
<td>Checkbox</td>
<td>Unchecked</td>
<td>No</td>
</tr>
<tr>
<td><strong>Agent Desktops Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Agent Desktops</td>
<td>The Agent Desktops associated with this Dialed Number.</td>
<td>Select from list and click Add.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td><strong>Agent Teams Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Agent Teams</td>
<td>The Agent Teams associated with this Dialed Number.</td>
<td>Select from list and click Add.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>*** Labels Tab**</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Labels</td>
<td>The Labels associated with this Dialed Number.</td>
<td>Select from list and click Add.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td><strong>Call Type Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Call Line ID</td>
<td>Required for Dialed Numbers mapped to voice media routing domains.</td>
<td>Select from the list</td>
<td>All</td>
<td>Yes</td>
</tr>
<tr>
<td>Call Entered Digits</td>
<td>Required for Dialed Numbers mapped to voice media routing domains.</td>
<td>Select from the list</td>
<td>All</td>
<td>Yes</td>
</tr>
<tr>
<td>App String</td>
<td>Required for Dialed Numbers mapped to non-voice media routing domains</td>
<td>Select from the list</td>
<td>All</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Managing Call Types

#### Page Access and Use

Use the Call Types page to create, edit, and delete call types. To open the page, from the Web Administration menu, select System Manager > Resource Folder > New ▼> Resource Item > Call Type.

#### What is a Call Type?

A call type is a category of incoming routable task. Specific call types are associated in Unified CCE with Dialed Numbers. In this association, each call type has a schedule that determines which routing script or scripts are active for that call type at any time.

**Note** it is not currently possible to associate Dialed Numbers with Call Types in the Management Portal.

There are two classes of call type/dialed number associations:

- **Voice** call type/dialed number combinations such as phone calls are categorized by the dialed number (DN), caller-entered digits (CED), and calling line ID (CLID). The CED and CLID can be optional, depending on the call.

- **Non-voice** type/dialed number combinations (such as e-mail and text chat) are categorized by the Script Type Selector, Application String 1, and Application String 2. Application String 1 and Application String 2 can be optional, depending on the application.

Because the call type determines which routing script is run for a call, the call type defines call treatment in a Unified CCE system. Therefore, the call type is the highest level reporting entity. Reporting on call type activity provides insight into end-to-end customer interactions with the system and with agents by providing data such as service level adherence, transfers, average speed of answer, calls handled, and calls abandoned.

In routing scripts you can change the call type at specific points in the script to indicate that a transaction has been completed. For example, if the customer is calling a bank and successfully checks his or her account balance using a Self-Service script, you may want to change the call type to indicate that the account balance transaction has completed and a new transaction has begun. You can also change call type in a script to invoke a new routing script associated with that call type. For example, if a call is not answered at an agent's desktop, you can change the call type in the script to...
redirect the call to a different script designed for Redirection on No Answer. The Redirection on No Answer script assigns a different agent to handle the call.

Creating a Call Type

To create a call type:
1. In the Items panel, click New > Resource Item > Call Type.
2. Enter a unique name of up to 24 characters for the call type. This can contain alphanumeric characters, periods, and underscores only.
3. Complete fields as described in the Call Type Fields table below.
4. Click Save.

Task Result

Once you have created a call type you can reference it in a dialed number configuration through Unified CCE.

Deleting a Call Type

To delete one or more call types:
1. In the Items panel, select the call type record(s) you want to delete.
   Note you cannot delete the default call type
2. Click Delete.
3. A message prompts you to confirm the deletion. Click OK.
   Note deleting a call type automatically removes it from any dialed number mappings in which it is referenced.

Call Type Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details Tab</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>A unique name for the record.</td>
<td>Unique. Up to 24 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Description</td>
<td>An internal description of the record.</td>
<td>Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Service level threshold</td>
<td>Optionally, use to indicate whether this call type will use a service level</td>
<td>Select from Use global setting, None, and Use specified. For Use specified, you must also enter a number in seconds from 0-99999</td>
<td>Use global setting</td>
<td>No</td>
</tr>
<tr>
<td>Service level type</td>
<td>Optionally, use to indicate how abandoned calls must be factored in</td>
<td>Select from Use global setting, Ignore Abandoned Calls, Abandoned Calls Have Negative Impact, and Abandoned Calls Have Positive Impact.</td>
<td>Use global setting</td>
<td>No</td>
</tr>
<tr>
<td>Bucket Interval</td>
<td>Use to indicate how the call type data must be stored for reporting purposes.</td>
<td>Select from drop-down list</td>
<td>Null</td>
<td>No</td>
</tr>
</tbody>
</table>
### Managing Labels

**Page Access and Use**

Use the Labels page to create, edit, and delete labels. To open the page, from the **Web Administration** menu, select **System Manager > Resource Folder > New ▼ > Resource Item > Label**.

**What is a Label?**

In Unified CCE the label represents a string that is passed to a routing client for each network target. Unified CCMP will automatically create labels for many high level operations but the functionality is included for specific label creation such as blind transfers. The only label type supported will be type Normal, the only network target is device target.

**Creating a Label**

To create a label:

1. In the **Items** panel, click **New > Resource Items > Label**.
2. Enter a unique name of up to 24 characters for the label. This must contain alphanumeric characters, periods and underscores only.
3. Complete fields as described in the Label Fields table below.
4. Click **OK**.

**Deleting a Label**

To delete one or more labels:

1. In the **Items** panel, select the label record(s) you want to delete.
2. Click **Delete**. A message prompts you to confirm the deletion.
3. Click **OK**.

### Advanced Tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enterprise Name</td>
<td>The name that will represent the Call Type within the network.</td>
<td>Unique. Up to 24 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
</tr>
<tr>
<td>Active From Date</td>
<td>The date from which this Call Type must be active within the system</td>
<td>Select from calendar</td>
</tr>
<tr>
<td>Active To Date</td>
<td>The date after which this Call Type must be deleted from the system</td>
<td>Uncheck <strong>Forever</strong> box and select from calendar</td>
</tr>
</tbody>
</table>

### Default and Required?

<table>
<thead>
<tr>
<th>Default</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Name</td>
<td>Yes</td>
</tr>
<tr>
<td>Current date</td>
<td>Yes</td>
</tr>
<tr>
<td>Forever</td>
<td>No</td>
</tr>
</tbody>
</table>
Label Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Details Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>A unique name for the record.</td>
<td>Unique. Up to 24 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the record.</td>
<td>Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Routing Client</td>
<td>The enterprise name of the routing client associated with this label</td>
<td>Select from the supplied list of routing clients that the logged in user has the security privileges to see.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Dialed Numbers Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dialed Numbers</td>
<td>The Dialed Numbers to associate with this label</td>
<td>Select from list and click Add.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td><strong>Advanced Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Active From Date</td>
<td>The date from which this label must be active within the system</td>
<td>Select from calendar</td>
<td>Current date</td>
<td>Yes</td>
</tr>
<tr>
<td>Active To Date</td>
<td>The date after which this label must be deleted from the system</td>
<td>Uncheck Forever box and select from calendar</td>
<td>Forever</td>
<td>No</td>
</tr>
</tbody>
</table>

Equipment Management

Managing IP Phones

Page Access and Use

Use the IP phones page to create, edit, and delete telephones. To open the page, from the Web Administration menu, select System Manager > Resource Folder > New ▼ > Resource Item > IP Phone.

Using Portal with Other Provisioning Systems

When using a separate provisioning system to add IP phones to a Unified Communications Manager, check the Contact Center enabled checkbox for all the Directory Numbers provisioned by the external system to ensure that they are added correctly to the Unified CCE. Do not attempt to make any other changes to phones on that Unified CM using Portal.

What is an IP Phone?

A telephone is the IP device that the contact center agent uses to make or receive calls. The telephone has a single line (typically line 1 if using a Cisco multi-line phone), whose number is known to the call routing software. The agent logs into the contact center using the Cisco CTI OS client desktop using the login name and password allocated by the Manage Agent portal page and the line number allocated in this page.

Creating an IP Phone

To create an IP Phone:
1. In the **Items** panel, click **New > Resource Items > IP Phone**.

2. Select the phone type from the drop-down list.

3. Complete fields as described in the IP Phone Fields table below.

4. Optionally add directory numbers by checking the boxes of numbers to add and clicking **Add**.

5. Click **Save**.

Once you have created an IP phone its status will initially be shown as **Not Ready**. The telephone will not be ready to use until this status changes to **Available**. This change usually occurs within a few minutes of saving.

**Deleting an IP Phone**

To delete one or more telephones:

1. In the **Items** panel, select the telephone record(s) you want to delete.

2. Click **Delete**.

3. A message prompts you to confirm the deletion. Click **OK**.

**IP Phone Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Details Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>A unique name for the record.</td>
<td>Unique. Up to 24 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Description</td>
<td>An internal description of the record.</td>
<td>Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Type</td>
<td>The model of telephone.</td>
<td>Select from list.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Template / Change</td>
<td>The XML template to be used to configure the IP Phone on the Unified Communications Manager.</td>
<td>Select from list of templates available for the specific phone model. When editing an IP Phone, you must check <strong>Change Template</strong> to show the Template field.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Template</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Button Template</td>
<td>The configuration to use for the buttons on the Unified Communications Manager</td>
<td>Select from list of button templates set up for the Unified Communications Manager.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>MAC Address</td>
<td>The MAC Address of the IP phone used to uniquely identify it.</td>
<td>12-digit hexadecimal number.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Directory Numbers Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Directory Numbers</td>
<td>The lines to be associated with the IP Phone</td>
<td>Select from list.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Index</td>
<td>The port on the IP Phone that the line is plugged into.</td>
<td>Number.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td><strong>Advanced Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unified CM</td>
<td>Unified CM to be associated with the IP Phone</td>
<td>Select from the list of Unified Communications Manager available for the tenant.</td>
<td>Default Unified CM</td>
<td>Yes</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required?</td>
</tr>
<tr>
<td>--------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>--------------------------------------------</td>
<td>---------------</td>
<td>-----------</td>
</tr>
<tr>
<td>Extension Mobility</td>
<td>Enables the Extension Mobility Service on the phone allowing a user access via their associated device profile</td>
<td>Checkbox</td>
<td>False</td>
<td>No</td>
</tr>
<tr>
<td>Peripheral</td>
<td>The Peripheral to be associated with the IP Phone.</td>
<td>Select from the list of Peripherals associated with the selected Unified CM.</td>
<td>Default Peripheral</td>
<td>Yes</td>
</tr>
<tr>
<td>Device Pool</td>
<td>A pool of phones that have similar character.</td>
<td>Select from the list of Device Pools available to the logged in user.</td>
<td>Default Device Pool</td>
<td>No</td>
</tr>
<tr>
<td>Active From Date</td>
<td>The date from which the IP Phone will be active in the system.</td>
<td>Select from calendar.</td>
<td>Current date</td>
<td>Yes</td>
</tr>
<tr>
<td>Active To Date</td>
<td>The date after which the IP Phone must be deleted from the system.</td>
<td>Uncheck <strong>Forever</strong> and select from calendar.</td>
<td>Forever</td>
<td>No</td>
</tr>
</tbody>
</table>

**Advanced Information**

Unified CCP automatically links or adds default additional information to Unified CCE as follows:

- Links Unified CM *calling search space* from the tenant owning folder
- Links Unified CM *route partition* from the tenant owning folder
- Links Unified CM *owner user ID* from the PG user id allocated to the tenant
- Links Unified CM *location* from the parent folder
- Creates Unified CCE *device target* for the phone/line.
- Creates Unified CCE *label* for each combination of *device target* and routing client (to route calls to an Unified CCE agent, you must have defined a *label* associated with the *device target*).

**Managing Directory Numbers**

**Page Access and Use**

Use the Directory Numbers page to create, edit, and delete numbers. To open the page, from the **Tools** page, select **System Manager > Resource Folder > New ▼ > Resource Item > Directory Number**.

**What is a Directory Number?**

A directory number is an extension line which is attached to an IP Phone.

**Creating a Directory Number**

To create a Directory Number:

1. In the **Items** panel, click **New ▼ Resource Items ▼ Directory Number**.
2. Select whether the number is **Contact Center Enabled**.
3. Complete fields as described in the Directory Number Fields table below.
4. Click **Save**.
Deleting a Directory Number

To delete one or more numbers:
1. On the Items panel, select the number record(s) you want to delete.
2. Click **Delete**.
3. A message prompts you to confirm the deletion. Click **OK**.

Directory Number Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Details Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>A unique name for the record.</td>
<td>Unique. Up to 24 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Description</td>
<td>An internal description of the record.</td>
<td>Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Contact Center Enabled</td>
<td>Determines whether a Device Target must be created on the Unified for this number. This must be checked for any phones added using a different provisioning system.</td>
<td>Checkbox</td>
<td>Unchecked</td>
<td>No</td>
</tr>
<tr>
<td><strong>Advanced Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unified CM</td>
<td>Unified CM to be associated with the Directory Number.</td>
<td>Select from the list of Unified CM available for the tenant.</td>
<td>Default Unified CM</td>
<td>Yes</td>
</tr>
<tr>
<td>Route Partition</td>
<td>The group of numbers (such as area codes or internal numbers) that this number is to be associated with.</td>
<td>Select from list.</td>
<td>Default Peripheral</td>
<td>Yes</td>
</tr>
<tr>
<td>Automatically Allocate a Number Pattern/Number Pattern</td>
<td>Whether to automatically allocate the number to be used for this Directory Number.</td>
<td>Checkbox. Uncheck box to enter number of 1-20 digits manually in the <strong>Number Pattern</strong> text box that appears.</td>
<td>Checked</td>
<td>Yes</td>
</tr>
<tr>
<td>Active From Date</td>
<td>The date from which the Directory Number will be active in the system.</td>
<td>Select from calendar.</td>
<td>Current date</td>
<td>Yes</td>
</tr>
<tr>
<td>Active To Date</td>
<td>The date after which the Directory Number must be deleted from the system.</td>
<td>Select from calendar.</td>
<td>Forever</td>
<td>No</td>
</tr>
</tbody>
</table>
Managing Device Profiles

Page Access and Use

Use the Device Profile page to create, edit, and delete Device Profiles. To open the page, from the Web Administration menu, select System Manager > Resource Folder > New > Resource Item > Device Profile.

What is a Device Profile?

A device profile is the profile of an IP device that the contact center agent uses when they logon to a specific phone. It allows a specific set-up and line associations to persist for a given user regardless of the phone to which they login on.

Creating a Device Profile

To create a Device Profile:

1. In the Items panel, click New > Resource Items > Device Profile.
2. Select the device profile type from the drop-down list.
3. Complete fields as described in the Device Profile Fields table below.
4. Optionally add directory numbers by checking the boxes of numbers to add and click Add.
5. Optionally add users by checking the boxes of numbers to add and click Add.
6. Click Save.

Once you have created a device profile its status will initially be shown as Not Ready. The telephone will not be ready to use until this status changes to Available. This change usually occurs within a few minutes of saving.

Deleting a Device Profile

To delete one or more device profiles:

1. In the Items panel, select the device profile record(s) you want to delete.
2. Click Delete.
3. A message prompts you to confirm the deletion. Click OK.

Device Profile Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Details Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>A unique name for the record.</td>
<td>Unique. Up to 24 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Description</td>
<td>An internal description of the record.</td>
<td>Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Type</td>
<td>The model of telephone to which the profile is associated.</td>
<td>Select from list.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required?</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------------------------------</td>
<td>------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>Template / Change Template</td>
<td>The XML template to be used to configure the Device Profile on the Unified Communications Manager.</td>
<td>Select from list of templates available for the specific phone model. When editing a device profile, you must check <strong>Change Template</strong> to show the Template field.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Button Template</td>
<td>The configuration to use for the buttons on the Unified Communications Manager</td>
<td>Select from list of button templates set up for the Unified Communications Manager.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Directory Numbers Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Directory Numbers</td>
<td>The lines to be associated with the IP Phone.</td>
<td>Select from list.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Index</td>
<td>The port on the IP Phone that the line is plugged into.</td>
<td>Number.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td><strong>Users Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Users</td>
<td>The associated Unified CM users that may use this profile</td>
<td>Select from list.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td><strong>Advanced Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unified CM</td>
<td>The Unified CM to be associated with the Device Profile.</td>
<td>Select from the list of Unified CM available for the tenant.</td>
<td>Default Unified CM</td>
<td>Yes</td>
</tr>
<tr>
<td>Peripheral</td>
<td>The Peripheral to be associated with the IP Phone.</td>
<td>Select from the list of Peripherals associated with the selected Unified CM.</td>
<td>Default Peripheral</td>
<td>Yes</td>
</tr>
<tr>
<td>Device Pool</td>
<td>A pool of phones that have similar character.</td>
<td>Select from the list of Device Pools available to the logged in user.</td>
<td>Default Device Pool</td>
<td>No</td>
</tr>
<tr>
<td>Active From Date</td>
<td>The date from which the IP Phone will be active in the system.</td>
<td>Select from calendar.</td>
<td>Current date</td>
<td>Yes</td>
</tr>
<tr>
<td>Active To Date</td>
<td>The date after which the IP Phone must be deleted from the system.</td>
<td>Uncheck <strong>Forever</strong> and select from calendar.</td>
<td>Forever</td>
<td>No</td>
</tr>
</tbody>
</table>
Audio Management

Managing VRU Scripts

Page Access and Use

Unified CCMP allows you to change the audio file associated with a network VRU script.

Note You cannot create a new VRU Script through the Management Portal.

To open the page, from the System Manager, navigate to the correct folder in the left-hand panel, choose Network VRU Script from the summary list of items, and select a specific VRU Script from the list shown in the Items panel. This will show you the details of the script.

What is a Network VRU Script?

A Network VRU (voice response unit) is a telecommunications computer, also called an Interactive Voice Response (IVR) unit, that responds to caller-entered touch-tone digits. This uses routing scripts to process a call. At various stages, this may run a VRU script to play a message to the caller, such as a repeated announcement when they are in a call queue.

How to Associate a VRU Script with an Audio File

To change the audio file associated with a VRU script:

1. In the Items panel, click a VRU script to associate with an audio file. The details for this script will open in the right-hand Details panel
2. Select the Audio tab.

   Note if no Audio tab is available, this may mean that the Network VRU Script has not been configured correctly. Contact your system administrator.

3. Click Save.

   Note the audio file will be saved under the name configured in the VRU script, replacing any previous audio file.

Code and Variable Management

Managing User Variables

Page Access and Use

Use the Create a New User Variable page to create and delete user variables. User variables cannot be edited once created. To open the page, from the Web Administration menu, select System Manager > Resource Folder > New ▼> Resource Item > User Variable.

What is a User Variable?

A user variable is a named object which can hold a value up to 40 characters long. Variables are used in routing scripts.

Creating a User Variable

To create a user variable:
1. On the **Items** panel, click **New ▼ > Resource Item > User Variable**.

2. Complete fields as described in the User Variable Fields table below. Active from and to dates can be set in the **Advanced** tab.

   **Note** Unified CCE requires that all user variable names begin with the string 'user'. The **Code Text** will therefore automatically be prefixed with this string on saving. For example, if you enter a **Code Text** of 'Temp', the resulting user variable will be called 'userTemp'.

3. Click **Save**.

   **Note** user variables cannot be edited after creation.

**Creating Bulk User Variables**

In addition to creating user variables one at a time, you can also bulk load user variable records previously output to a CSV (comma separated values) file. See the Bulk Upload section for further information.

**Deleting a User Variable**

To delete one or more user variables:

1. In the **Items** panel, select the user variable(s) you want to delete.
2. Click **Delete**.
3. A message prompts you to confirm the deletion. Click **OK**.
User Variable Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details Tab</td>
<td>Code Text</td>
<td>The name of the user variable. Up to 32 characters, consisting of letters, numbers, periods and underscores only. This does not need to begin with the string ‘user’.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Object Type</td>
<td>The type of object with which to associate the variable. You may choose not to associate the user variable with an object by selecting User Variable.</td>
<td>Select from list</td>
<td>Null</td>
</tr>
<tr>
<td></td>
<td>Data Type</td>
<td>The data type for the variable. Select from list</td>
<td>Long</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Persistent</td>
<td>Whether the user variable retains value across Central Controller restarts. Checkbox.</td>
<td>Checked</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>A description of the variable and how it must be used. Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Advanced Tab</td>
<td>Active From Date</td>
<td>The date from which the variable will be active in the system. Select from calendar.</td>
<td>Current date</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Active To Date</td>
<td>The date after which the variable must be deleted from the system. Uncheck Forever and select from calendar.</td>
<td>Forever</td>
<td>No</td>
</tr>
</tbody>
</table>

Managing Expanded Call Variables

Page Access and Use

Use the Create an Expanded Call Variable page to create and delete expanded call (ECC) variables. To open the page, from the Tools page, select System Manager > Resource Folder > New ▼ Resource Item > Expanded Call Variable.

What is an Expanded Call Variable?

An expanded call variable is a named object which is used by a VRU script to exchange call information with Unified CCE.

Creating an Expanded Call Variable

To create an expanded call variable:

1. In the Items panel, click New ▼ Resource Item > Expanded Call Variable.
2. Complete fields as described in the Expanded Call Variable Fields table below. Active from and to dates can be set in the Advanced tab.

3. Click Save.

**Deleting an Expanded Call Variable**

To delete one or more expanded call variables:

1. In the Items panel, select the expanded call variable(s) you want to delete.
2. Click Delete.
3. A message prompts you to confirm the deletion. Click OK.

**Expanded Call Variable Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Details Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>The name of the call variable</td>
<td>Unique. Up to 24 characters, letters, numbers, and underscore characters only. Must begin with letter or number.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Description</td>
<td>The description of the call variable</td>
<td>Up to 255 characters</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Maximum Length</td>
<td>The maximum length of the value of the call variable</td>
<td>Up to 210</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Provided by Cisco</td>
<td>Whether the call variable provided by Cisco. This is normally determined by the system</td>
<td>Checkbox</td>
<td>Unchecked</td>
<td>No</td>
</tr>
<tr>
<td>Persistent</td>
<td>Whether the variable is written to the historical database with the TCD/RCD record</td>
<td>Checkbox</td>
<td>Unchecked</td>
<td>No</td>
</tr>
<tr>
<td>Enabled</td>
<td>Whether the call variable is currently enabled</td>
<td>Checkbox</td>
<td>Checked</td>
<td>No</td>
</tr>
<tr>
<td>ECC Array</td>
<td>Whether the variable is an array</td>
<td>Checkbox</td>
<td>Unchecked</td>
<td>No</td>
</tr>
<tr>
<td>Maximum Array Size</td>
<td>The maximum size of elements in the array represented by the call variable</td>
<td>Up to 255. The equation &lt;Maximum Length&gt; * &lt;Maximum Array Size&gt; + &lt;Maximum Array Size&gt; + 5 must not exceed 299. For example, if the Maximum Length was 97, the array size could not exceed 3.</td>
<td>Null</td>
<td>If ECC Array checked</td>
</tr>
</tbody>
</table>

**Advanced Tab**
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enterprise Name</td>
<td>The name to be used for the expanded call variable within the system</td>
<td>Unique. Up to 24 characters,</td>
<td>Created from variable name. Enterprise names for expanded call variables are automatically prefixed with 'user' by the system.</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td>letters, numbers, and underscore characters only. Must begin with letter or number.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Active From Date</td>
<td>The date from which the variable will be active in the system.</td>
<td>Select from calendar.</td>
<td>Current date</td>
<td>No</td>
</tr>
<tr>
<td>Active To Date</td>
<td>The date after which the variable must be deleted from the system.</td>
<td>Uncheck <strong>Forever</strong> and select from calendar.</td>
<td>Forever</td>
<td>No</td>
</tr>
</tbody>
</table>

Overview

Security management in Unified CCMP is folder based, and therefore a basic folder structure needs to be in place before security can be set up. Users are granted permissions to perform certain tasks within specified folders, and these permissions are inherited by the child folders and on down through the folder tree.

Inheritance and Policy Root Folders

By default, all folders except the tenant folder inherit the permissions of their parent. The tenant folder is therefore considered the root folder for a single security policy. This inheritance link can be broken for individual folders, allowing separate permissions to be applied to them. These folders become policy roots, with their child folders inheriting their permissions.

Users and Groups

Users can belong to groups of users that have the same permissions. The permissions assigned to that group apply to all members of that group.

Groups may be members of other groups. For example, if you wanted users with permissions over the San Francisco policy root to have permissions only within the San Francisco tree, but users with permissions within the New York policy root to have permissions within both New York and San Francisco, you could create a group.
for each policy which had permissions only within that policy, and then make the New York group a member of the San Francisco group.

Both users and groups may be members of more than one group.

Users and groups are created, moved, edited and deleted from the User Manager and the Group Manager links on the ‘Tools’ page. To assign permissions to a user or group use the Security Manager.

**Default Groups**

Creating a policy root automatically creates a number of default groups within the policy root folder, with permissions over that policy. The groups that are created, and the permissions they are assigned, can be set from the System Settings page.

Two default groups are also present in the Root folder. These are:

- **Everyone** allows users to browse the Shared and Unallocated folders, and to which users are automatically assigned on creation.
- **Administrators** provides the host administrator with full permissions throughout the system.

These groups cannot be edited, although users and groups may be assigned to them or removed from them as normal.

**Permissions**

Individual permissions (or tasks), such as creating agents or viewing resources, are gathered together into roles. Permissions for users and groups are then granted by means of these roles. There are two kinds of role that must be used to grant permissions:

- **Global roles** globally ‘switch on’ the ability to perform certain kinds of action within the system, such as the ability to access the Security Manager tool.
- **Folder roles** specify the tasks which may be performed within individual folders, for example the ability to manage security within a specific tenant folder.

For example, a user would need to have both a global role granting security management permissions, and a folder role granting permission to manage security within a particular folder, in order to manage security for that folder.

Global roles are created, edited and assigned to users and groups from the Global Security Manager link on the ‘Tools’ page. Folder roles are created and edited from the Role Manager link on the ‘Tools’ page. To assign folder roles to users or groups, use the Security Manager.
Default Roles
A number of default roles are provided with the system. These roles are shown below.

Default global roles:
- **Global Advanced** contains tasks for advanced users allowing them to provision all items and access all tools.
- **Global Basic** contains tasks to perform basic report and provisioning for agents/teams and skill groups.
- **Global Host** all functions.

Default folder roles:
- **Advanced** – provides advanced functions on a given folder such as provisioning of item types, folder creation and security management
- **Basic** provides standard basic functionality e.g. reporting, team management and re-skilling.
- **Full Permissions** all functions.
- **My Reports** provides report access at a specified location.
- **Supervisor** allows manage dimension and user permissions.

Creating and Managing Global Roles
Global roles are collections of tasks that specify the permissions a user has the potential to perform within the system. For example, a user assigned a global role that includes the 'System Manager' task has the potential to access the System Manager tool if they are assigned folder roles that require this. Global roles are not contained within individual folders, but exist throughout the system and can be applied to any user or group.

Global Security can normally only be managed by Host Administrators, but it is possible to allow tenant administrators to grant users and groups global permissions without assigning them full global security permissions by setting up ‘global permissions groups’ in each tenant root, each of which has been uniquely assigned a particular global role.

Global roles can be managed from the **Global Security Manager** link on the Tools page.

Managing Global Roles
The roles that are needed in Unified CCMP are determined by the requirements of the different categories of user who will be working within that system.

To create a global role:

1. In the **Global Security Manager**, click **New**.
2. Give the new role a **Name** reflecting the permissions it grants or the category of user it is intended for.
3. Add a **Description** if necessary, such as a summary of the permissions granted.
4. Check the tasks to be included in this role.

5. Save.

To grant or remove global permissions

1. In the **Global Security Manager**, click the name of the global role to be granted to users or groups. Its properties display.

2. Click **Members** tab.

From here, you can click the cross by any member to remove that member. To add members:

1. Click **Add Members**. A pop-up opens.

2. Navigate through the folder tree on the left to the folder containing the users or groups to be assigned this global role. You can use the fields at the top to filter this view to show only users or only groups, or to search for specific names.

3. Check the checkbox of the new members. You may select users and groups from multiple folders.

4. **Close** and **Save**.

To edit a global role, click its name and change its details, or add and remove tasks and members, as desired.

To delete a global role, check its checkbox, click **Delete**, and confirm.

**Note** you will not be able to delete a global role that still has members.

### Creating and Managing Folder Roles

Folder roles are sets of permissions that users and groups may be granted on specific folders. They are not contained within individual folders, but exist throughout the system and can be applied to any user or group for any folder.

Folder roles can be managed from the **Role Manager** link on the **Tools** page. To grant users roles on specific folders, use the **Security Manager**.

### Managing Folder Roles

The roles that are needed in Unified CCMP are determined by the requirements of the different categories of user who will be working within that system. For each folder role created there must be a global role which provides all the global permissions necessary to allow performance of the tasks specified. A global role that provides more permissions than those required can normally be safely used for this purpose if necessary.

For example, if a folder role exists that contains the task 'Manage Dimensions', there must also be a global role containing the 'System Manager' task along with one or more of the 'Provision Agent', 'Provision AgentDesktop' etc tasks, depending on which dimensions the folder role is intended to allow users to manage.

**Note** by default, only host administrators can manage roles.

To create a folder role

1. In **Role Manager**, click **New**.

2. Give the new role a **Name** reflecting the permissions it grants or the category of user it is intended for.
3. Add a **Description** if necessary, such as a summary of the permissions granted or a notation of which global roles are suitable for use with this folder role.

4. Check the tasks to be included in this role.

5. **Save.**

To edit a folder role, click its name and change its details, or add and remove tasks as desired.

To delete a folder role, check its checkbox, click **Delete**, and confirm.

**Note** you will not be able to delete a folder role that is being used.

**Creating and Managing Users**

The **User Manager** link on the **Tools** page allows you to create, edit and delete users, or add them to groups. To grant users permissions on specific folders, use the **Security Manager**.

**Creating a User**

Unified CCMP treats user accounts similarly to resources. That is, each user account must be contained within a specific folder, and users with appropriate permissions on that folder can change the user’s properties (such as the password) or move or delete the account.

The folder that contains a user account has no effect on the permissions of that user.

To create a user

1. Open **User Manager**.

2. From the folder tree on the left, select the folder in which to create the new user.

3. Click **New**. The **Create a new user** page opens.

4. Enter the following details:

   - **User Name** field enter the name for the new user account. The user will use this name to login to Unified CCMP
   - **Password** field enter the password for the new user.
   - **Confirm Password** field re-enter the selected password.
   - **First Name** and **Last Name** fields enter the user's details.
   - **Email** field enter the email address (if any) of the new user.
   - **Description** field, optionally enter any explanatory text, such as a job title.
   - **User Home Folder** that the user will start in when they log in. If you leave this blank, it will automatically be set to the folder the user is created in.
     **Note** that basic users will be unable to navigate out of this folder.

5. Select any of the following checkboxes which are applicable:

   - **Advanced** checkbox if the user is to be assigned global roles that allow them to access Advanced Mode tools such as the System Manager.
     **Note** the number of advanced users must be limited as far as is practical.
• **Enabled** checkbox to ensure that the user is live in the system. If unchecked the new user account will be saved in the system, but the user will not be able to login.

• **User must change password at next Logon** checkbox to prompt the new user to change their password after their first login.

• **Password Never Expires** checkbox to assign the password to the new user indefinitely.

• **User cannot change password** checkbox to prevent the new user from changing their own password (it can still be changed by administrators).

• If you wish to create more than one user, select the **Create Another** checkbox to remain on the **Create a new user page**.

6. Click **OK**.

**Managing Users**
To edit a user's details:
1. Open **User Manager**.
2. From the folder tree on the left, select the folder containing the user to be moved.
3. Click the user. A page showing the user details opens.
4. Edit details as desired. The user's password can be changed from the **Password** tab, and the user can be added or removed from groups using the **Groups** tab.

To move a user:
1. Open **User Manager**.
2. From the folder tree on the left, select the folder containing the user to be moved.
3. Check the user's checkbox.
4. Click **Move**. The **Move a user** page opens.
5. Navigate to the folder you want to move the user to.
6. Click **Save**.
   Alternatively, click the user name and click **Move** from the user details page.

To delete a user:
1. Open **User Manager**.
2. From the folder tree on the left, select the folder containing the user to be deleted.
3. Check the user's checkbox.
4. Click **Delete** and **Confirm**.

**User Permissions**
To grant a user permissions on specific folders, use the **Security Manager**. For ease of maintenance, permissions must be assigned through group memberships.

To see a user's permissions:
1. Open **User Manager**.
2. From the folder tree on the left, select the folder containing the user.
3. Click the user. A page showing the user details opens.

4. Click Access. The roles the user can perform on each folder are shown. 

**Note** the Access option does not show whether these permissions have been assigned directly to the user or through group memberships.

To change a user's group memberships - the **Groups** tab

1. Open **User Manager**.
2. From the folder tree on the left, select the folder containing the user.
3. Click the user. A page showing the user details opens.
4. Select the **Groups** tab.

From the **Groups** tab, you can remove the user from groups by clicking on the cross icon beside each group. You can also add the user to new groups, as follows:

1. Click **Add to Group**. A pop-up opens.
2. Navigate through the folder tree on the left to the folder containing the group the user is to be added to.
3. Check the checkbox of the group or groups. You may select groups from multiple folders.
4. **Close** and **Save**.

**Creating and Managing Groups**

The **Group Manager** link on the **Tools** page allows you to create, edit and delete groups and their memberships. To grant groups roles on specific folders, use the **Security Manager**.

**Creating a Group**

Unified CCMP treats groups similarly to resources. That is, each group must be contained within a specific folder, and users with appropriate permissions on that folder can change the group’s properties.

The folder that contains a group has no effect on the permissions of that group.

To create a group:

Open the **Group Manager**

1. From the folder tree on the left, select the folder in which to create the new user
2. Click **New**. The **Create a new group** page opens.
3. Enter the following details:
   - **Name** field enter the name for the new group. Groups in different folders may have the same name.
   - **Description** field enter a description for the group, such as a summary of its permissions or the categories of users it is intended for.
4. If you wish to create more than one group, select the **Create Another** checkbox to remain on the **Create a new group** page.
5. Click **OK**.
Managing a Group

To edit a group's details:
1. Open the Group Manager.
2. From the folder tree on the left, select the folder containing the user to be moved.
3. Click the group. A page showing the group details opens.
   Edit details as desired. Members of the group can be added or removed using the Members tab, and the group itself can be added to or removed from others using the Groups tab.

To move a group:
1. Open the Group Manager.
2. From the folder tree on the left, select the folder containing the group to be moved.
3. Check the group's checkbox.
4. Click Move. The Move a group page opens.
5. Navigate to the folder you want to move the group to.
6. Click Save.

Alternatively, click the group name and click the Move option from the details page.

To delete a group:
1. Open the Group Manager.
2. From the folder tree on the left, select the folder containing the group to be deleted.
3. Check the group's checkbox.
4. Click Delete and Confirm.

Group Permissions

To see a group's permissions:
1. Open the Group Manager.
2. From the folder tree on the left, select the folder containing the group.
3. Click the group. A page showing the group details opens.
4. Click Access. The roles that members of this group can perform on each folder are shown.

Note the Access option does not show whether these permissions have been assigned directly to the group or are 'inherited' through membership of other groups.

To change the members of a group - the Members tab:
1. Open the Group Manager.
2. From the folder tree on the left, select the folder containing the group.
3. Click the group. A page showing the group details opens.
4. Select the Members tab.

From the Members tab, you can remove members by clicking on the cross icon beside their names, or add members as follows:
1. Click the **Add to Group** button. A pop-up opens.
2. Navigate through the folder tree on the left to the folder containing the users or groups to be added to the current group. You can use the fields at the top to filter this view to show only users or only groups, or to search for specific names.
3. Check the checkbox of the new members. You may select users and groups from multiple folders.
4. **Close** and **Save**.

To change the groups a group is member of - the **Groups** tab:
1. Open the **Group Manager**.
2. From the folder tree on the left, select the folder containing the group to be added to, or removed from, others.
3. Click the group. A page showing the group details opens.
4. Select the **Groups** tab.

From the **Groups** tab, you can remove the group from groups it is a member of by clicking the cross icon beside each, or add it to groups as follows:
1. Click the **Add to Group** button. A pop-up opens.
2. Navigate through the folder tree on the left to the folder containing the group the current group is to be added to.
3. Check the checkbox of the group or groups. You may select groups from multiple folders.
4. **Close** and **Save**.

## Assigning Folder Permissions

Folder permissions are assigned using the **Security Manager** link from the **Tools** page. From the **Security Manager** you can also edit folder roles, users and groups by clicking on the name of the item to be edited.

To see the permissions users and groups have on a particular folder, select that folder from the folder tree on the left. All the permissions users or groups have on the selected folder are shown in the **Permissions** tab.

To grant folder roles to users or groups:
1. From the tree on the left, select the folder containing the user or group.
2. Click **Users** or **Groups** tab depending on whether you are applying permissions to a user or to a group.
3. Check the users or groups to be granted permissions (you may assign permissions to both users and groups at the same time).
4. Click **Change Permissions**. A pop-up opens.
5. Select the folder that permissions are to be granted on. If the folder is a policy root, a list of available folder roles displays; if it is not, you will need to click **Edit Item Security** to break the inheritance link. If you break the inheritance link, the permissions that currently exist on the folder from inheritance will be copied in.
6. Check the permissions to be applied (or uncheck the permissions to be removed).
7. Optionally, check the **Change permissions for sub-folders** box to copy the changed permissions into all policy roots beneath the selected folder.

8. Click **Save**. You will be shown a summary of the permissions that will be changed.

9. **Confirm** to apply the new permissions.

**Note** in order to provision some items, users may need browse permissions on related items. For example, in order to modify Agent and/or Skill Group configuration, a user must be able to see the Peripheral that they belong to.

**Changing a Folder's Inheritance**

To change a folder's inheritance:

1. From the tree on the left, select the folder to be made a policy root.

2. In the **Permissions** tab, uncheck the **Inherit permissions from parent** checkbox (or check it to reapply inheritance).

3. Click **OK** to confirm. If you break the inheritance link, the permissions that currently exist on the folder from inheritance will be copied in. These can then be changed if necessary.

It is also possible to make a folder into a policy root by applying permissions to it, as described above.
7. Service Management

Configuring Service Management

The Team Management and Agent ReSkilling tools available through the Service Management section of Unified CCMP rely on the user accessing Unified CCMP, being associated to a related Unified ICM Person resource.

To manage a set of agents using these tools the user must be associated to the Unified ICM Person resource, which is associated to the Supervisor Agent resource whom is supervising the Agent Team containing the agents which are to be managed.

These tools obviously rely on Agent Teams being configured with their associated supervisors set up correctly within Unified ICM. Once these logical groups of agents exist then the following steps must be performed to create a Unified CCMP user that can utilize these tools:

1. Log in to the Unified CCMP using an Administrator account.
2. Open the System Manager tool and navigate to the folder containing the Supervisor Agent.
3. Open the Supervisor Agent and choose the Person tab.
4. Click the Edit Person button (green arrow).
5. Go to the Portal tab.
6. Specify User Name and Password for the new Unified CCMP user.
7. Select the Tenant User and Supervisor groups for default permissions.
8. Click Save to create the Unified CCMP user.

Note in the case that a User has already been created, there is no interface to allow this user to be associated to the Agent – a new User must be created. The default system administrator user may not be associated to an ICM Person resource. Agents, Teams and Skill Groups must be managed through the System Manager Tool.

Team Management

The Agents option allows supervisor agents to manage the agents in their agent teams.

Each Agent is associated with a Person, which represents an actual physical person who performs customer contact duties. A Person may be associated with more than one Agent. For example a person who alternates between two teams on different peripherals would need to be associated with two Agents, one on each peripheral.

To see an agent team, click My Agent Team drop-down list and select the team you wish to work with. A list of the agents in the team will be shown below the box.

The agent list shows each agent's name, their status within the system (such as Ready or Pending), and the date from which they have been active in the system (an Active From Date in the future indicates an agent who has not yet started work). There is also an agent details icon that allows you to view and edit agent details, and a
copy icon that allows you to create a copy of an agent (for example, if you wish to add to your team a new agent who has exactly the same skills as an existing agent).

To view or edit an agent:
1. Select an agent team from the drop-down list.
2. Click Agent. The Edit the current Agent page opens, showing you the agent's details.
3. Make any changes to the agent. Selecting a different tab (such as Supervisor or Agent Teams) will show a different set of fields. You can always go back to previous tabs.
   **Note** you are unlikely to need to use the Advanced tab unless you are changing start or finish dates for an agent.
4. Click Save to save your changes or Cancel to leave the agent's details as they were before you started editing.

To set an agent's starting or leaving date:
1. Select an agent team from the drop-down list.
2. Click Agent for the agent you wish to edit. The Edit the current Agent page opens, showing you the agent's details.
3. To set or change an agent's starting or finishing date, select the Advanced tab. You may either type in the date manually (it is in the format day/month/year) or:
   - Click Calendar beside the Active To Date (finish date) or Active From Date (start date) field. A calendar popup appears.
   - Make sure the month and year shown at the top are correct.
   - To change the month, click the pairs of arrows to the left and right to scroll through the months until you find the one you want.
   - To change the year, click the pairs of arrows to the left and right. Going right from December will take you to January of the next year, and vice versa.
   - Select the date.
4. Set the time on the selected date on which the agent is starting or finishing (for example, 17h 00m for someone leaving at the end of business hours).
5. Click Save to save your changes or Cancel to leave the agent's details as they were before you started.

To add a new agent:
**Note** All agents must be associated with a person. If a person record for the new agent does not already exist on the system, you can create one as part of adding a new agent.
1. Click New. The Create a New Agent page displays.
2. Fill in the fields for each tab.
3. All the fields that you must fill in are marked with a red asterisk. These fields are on the Details tab. The Save button will not be enabled until all the required fields have been filled in.
   - On the Details tab:
1. Fill in the Agent's Name (such as BOates or Beth_Oates).
2. Give a description of the agent (such as a job title).
3. Select a Peripheral to create the agent on (if you are a supervisor agent, this must be the same peripheral that you use). You will not be asked to select a peripheral if there is only one peripheral available.
4. Choose whether to associate the agent with an existing Person, or to create a new one. A Person can have more than one agent identity if all those agents are created on different peripherals.
   - Select an existing person from the drop-down list, or search for a specific person by typing a part of their name in the Search box. The new agent will use the details specified in that Person’s Peripheral Login box to log on to their Agent Desk Setting.
   - To Create a New Person, enter the first name and last (or family) name for the person, and fill in the details they will use to login to the peripheral. The person will be automatically created and associated with the agent.
     Note Multiple Agents may be associated with a single Person, if all Agents involved are on different peripherals.
   - In Supervisor tab:
     1. If the agent is to be a supervisor, check the Supervisor checkbox. If this box is checked, you will also need to set a domain account.
     2. If the agent is a supervisor, they must be associated with a domain account (the account they will use to log into a computer on the contact center network). Type in part of the account name, click Find and then select the correct account.
     Note you cannot set up a domain account from the Management Portal. Contact your IT department if you are uncertain of the domain account to use.
   - In Agent Teams tab:
     1. Select an agent team for the agent to belong to. Agents may only be a member of a single team, but a supervisor can supervise multiple teams. Use the Selected Path drop-down to see agent teams in other folders.
     2. Click Add to associate the team with this agent.
     3. Check Member to make the agent a member of the team. Supervisors can supervise a team without being a member.
     4. If the agent is a supervisor, they can supervise the team without being a member. Select a primary or secondary supervisory role for any team they are to supervise.
   - In Skillgroups tab:
     1. Select Skillgroups for the agent to belong to. Use the Selected Path drop-down list to change folders.
     2. Click Add to add the agent to the selected skill groups.
   - In the Advanced tab:
Note you will probably only edit these settings to set an agent's start or finish date.

1. **Enterprise Name** is the name the agent is known as within the Management Portal.

2. **Agent Extension** is the internal extension number for the agent.

3. **Agent Desktop** allows you to specify the agent's desk settings (also called the Agent Desk Setting).

4. **Check State Trace** if you wish to let the system track the agent’s state, such as whether they are logged off or talking.

5. Use the **Active From Date** box to set the agent's starting time and date (you may enter the date manually in day/month/year format, or select a date from the calendar).

6. Use the **Active To Date** box to set the agent's leaving date.

4. Check the **Create Another** checkbox to create another agent whose settings are identical to this agent’s except for their name and login details.

5. Click **Save** to create the agent, or **Cancel** to cancel agent creation and return to your homepage.

### Changing an Agent’s Team

To change an agent's team:

1. Select the agent team to which the agent belongs from the drop-down list.

2. Click **Agent Details** (not the copy icon beside it) for the agent you wish to edit. The **Edit the current Agent** page opens, showing you the agent's details.

3. Click **Agent Teams**. The agent's current team membership is shown.

4. Select the agent team and click **Remove**.

5. You may optionally select a team from the list below and click **Add** to add the agent to that team. You can add the agent either as a member of that team by checking **Member**, or as a primary or secondary supervisor if they are a supervisor agent.

6. Click **Save**.

### Agent Reskilling

The **Skillgroups** option allows you to view and edit agent skill groups.

To view a skill group, click **Skillgroup** drop-down list and select the skill group you wish to work with. A list of the agents associated with the skill group will be shown below the box. A complete list of all the agents who can be associated with the skill group (those who are on the same peripheral as the skill group) is shown below that.

The agent list shows each agent's name, their status (such as **R** for Ready or **S** for Synchronizing), and the date from which they are active in the system (an **Active From Date** in the future indicates an agent who has not yet started work). Clicking on the green arrow icon allows you to edit the agent.

To add an agent to a skill group:

1. Select a skill group for the agent or agents to belong to.
2. Select agents to belong to the skill group using the checkboxes. Use the **Selected Path** drop-down list to see agents in other folders.
3. Click **Add** to associate the agents with this skill group.
4. Click **Save** to save your changes, or **Cancel** to leave the details as they were before you started.

To remove an agent from a skill group:
1. Select a skill group to remove an agent or agents from.
2. In the top list, select agents to remove from the skill group using the checkboxes.
3. Click **Remove** to remove the agents from this skill group.
4. Click **Save** to save your changes, or **Cancel** to leave the details as they were before you started.

**Self-Skilling**

Self-Skilling is accessible through the basic mode tools menu or via the advanced mode **Service Manager** tool. Self-Skilling allows a Management Portal user associated with a valid Unified CCE person to update the skill groups to which they are assigned.

**Adding yourself to a Skill Group**

- If your Person is mapped to more than one Agent, select which Agent you wish to re-skill using the drop-down list provided.
- Browse to the folder where the skill groups are you wish to add yourself to.
- Check the box next to the skill groups you wish to join.
- Click **Add** and they appear in the Selected Skill Groups list.
- Click **Save** to commit the changes.

**Removing yourself from a Skill Group**

- If your Person is mapped to more than one Agent, select which Agent you wish to re-skill using the list-box provided.
- Check the box next to the skill group you wish to remove yourself from in the Selected Skill Groups list.
- Click **Remove** and they should disappear from this list.
- If you are the last person in any of these skill groups (and removing yourself would effectively leave this skill group un-manned), a confirmation window appears. Click **Ok** if you wish to continue or **Cancel** to abort.
- Click **Save** to commit the changes.
Glossary

A

Agent
Any contact center operative dealing with customers, usually by answering incoming phone calls. Each agent is associated with a peripheral and can be a member of one or more skill groups.

Agent Desk Settings
Settings for a Unified CCE agent's phone or PC screen. Agent desk settings can be associated with each Unified CCE agent or with a Unified CCE peripheral. Also called agent desktop.

Agent Desktop
See Agent Desk Settings.

Agent Team
Any organizational or functional grouping of agents. An agent team is generally served by the same peripheral and has a common business focus such as a specific aspect of technical support. Agents may belong to several teams and skill groups.

Aggregate
The sum total of many similar elements or a summary of underlying values. It may also refer to the minimum or maximum.

Alphanumeric
Consisting of both letters and numbers.

Announcement
A verbal message played to the caller.

Application log
A folder in the system that records details of events which have occurred in the system. The data recorded can be any data; this is determined by an appropriate system administrator.

Ascending
Defines a list as either starting with the letter A or with the lowest number (compare with Descending).

Assignment
The granting of specific task permissions to a user. See Role/Task.

Attribute
Attributes are features of the graphic user interface that can be customized, such as the company logo, screen colors or icons.

Audit
A report that provides data regarding the operation of the platform itself.

Automate
To define a procedure that is carried out electronically, and independent of manual intervention.

**B**

**Breadcrumb Trail**
The route by which the user arrived at the current help page. Each previous page in the 'trail' can be accessed by clicking the displayed link.

**Browser**
See Web Browser.

**C**

**Cache**
Memory on the application server, which stores the information used to generate a report for up to one month in case the information is required again.

**Call Type**
A category of routable task determined by dialed number (DN), caller-entered digits (CED) and calling line ID (CLID). Each call type has a schedule that determines which routing script or scripts are active for that call type at any time.

**Cell**
See Field.

**Chart**
A graphical means of displaying report data.

**Checkbox**
A small box displayed next to an entity in the system. By selecting the checkbox, the associated entity is made accessible for editing, deleting and so on.
**Child**

In folder terms a child folder is one that is contained within another folder, called the parent. A child inherits the security permissions of its parent folder. Note that a single folder may be both the child of one folder and the parent of another. See **Parent**.

**Cluster**

A grouping of similar resources, such as individual dialed numbers.

**Column**

In a table, a column is a vertical slice through the table rows. Each column consists of a certain kind of data, indicated by the column header, whose values appear in the fields beneath. See **Field**, **Row**.

**Comma Separated Variable (CSV)**

A method of representing a spreadsheet using a text file. The values are separated by commas, and each record is ended by a line break. The column headers are contained in the first record.

**Create**

To add an entity to the system, such as a new user, customer, resource or mapping.

**Credentials**

See **Permissions**.

**CSV**

See **Comma Separated Variable**.

**Customize**

To change an entity in the system to suit a unique purpose. Also to change the system settings to suit an individual user's requirements.

**D**

**Data**

The information generated by a computer based system.

**Data Field**

In analysis services, data fields provide the total values to be summarized in a report view.

**Data Mart**

A server running the Microsoft SQL Server analysis services application, which stores in memory the online analytical processing (OLAP) cubes used in report analysis.

**Database**

A catalog within the Microsoft SQL Server application that stores in memory the data used in reporting.

**Default**

The value that will be used when no alternative value is supplied by the user.

**Delete**

To remove an entity, parameter or mapping from the system.
Descending
Defines a list as either starting with the letter Z or with the highest number (compare with Ascending).

Destination
Code describing the target for an outgoing call (dialed number).

Destination Number
The telephone number to which the call was routed by the network. See Label.

Detail Field
See Total Field.

Dialed Number
The telephone number dialed by the calling party.

Dimension
A means of grouping and separating contact center data of a similar type in the SQL Server Analysis Services database. Also another term for a resource.

Drill down/up
To navigate through trees or data. Drill down to view child folders or data in finer detail and drill up to view parent folders or summarized data values.

Drillthrough
To use a field in one report to link to the same data item in another report.

Edit
To change the properties of an entity in the system.
Enable
To make an entity in the system either accessible or functional.

Enterprise
Collective term describing all parts of a company serviced by a single call distribution system. This may include several contact centers served by different peripherals.

Enterprise Service
Organizational grouping of agents within a company, perhaps spanning several contact centers and served by different peripherals, providing a specific customer service, such as technical support.

Enterprise Skill Group
Organizational association of contact center agents within a company, perhaps spanning several contact centers and served by different peripherals. Agents in a skill group share common talents such as technical or language abilities, or skills in dealing with complaints.

Error
An event on the platform that prevents it from operating as expected.

Excel
The spreadsheet application provided by Microsoft Corporation.

Exception
A value which falls outside set parameters. Exceptions may be highlighted for ease of identification. See Threshold.

Expire
A date and time, configured in the system, at which point a defined process or piece of information is rendered invalid.

Export
To save a report as a document type that can be published and distributed independently of the platform.

Extensible Markup Language (XML)
A markup language used to create special-purpose markup languages. It facilitates the sharing of data across different systems, particularly systems connected via the Internet.

Extension (filenames)
Different report format file names use a character extension that is unique to each format type.

Extension (telephone)
Either a telephone number that is local to the switch or a telephone station served by a PBX (Private Branch Exchange).
Field
An area in a table in which data can be included. The value in a field represents the value from the data represented by that specific row that belongs in the context defined by the column. See also Row, Column.

Filter
A means of choosing what data to view.

Folder
A system folder that can be linked to other folders in the system in parent/child relationships (compare with Tenant Folder). See also Parent, Child.

Generate
To run a report.

Global role
A role that applies throughout the entire system.

Graphical User Interface (GUI)
The front-end to the application that provides the user with the means to define and generate reports.

Group
A collection of users who share the same security permissions.

GUI
See Graphical User Interface.

Header
The field in a report grid which describes the contents of the column beneath it or the row beside it.

Hierarchy
A tree structure in which the root folder at the top of the tree is the parent folder to all the folders beneath it. Folders are organized into parent/child relationships in which the subordinate child folders inherit the security permissions of a parent folder. Tenant folders are unusual in being stand alone and unable to inherit the permissions of a parent folder.
Historical
Historical data reflects the past activities occurring in the organization.

HTML
See Hypertext Markup Language.

Hypertext Markup Language (HTML)
A markup language used to build web pages and other information which can be viewed in a web browser.

I
Icon
A picture displayed in the GUI that represents a system function or object. Some icons may be purely representative. Other icons, however, may be used as shortcuts to the object or function they represent. For example, the Properties icon acts as a link to the properties page in which the properties of the selected object may be modified.

IE
See Internet Explorer.

Import
To load data into the platform from an external source.

Increment
One of a series of regular additions. Specifically, the adding of a new version of a report to a list of previous versions.

Information Notice
Information notices are used to inform contact center staff of general information or new announcements. Information notices are displayed in the homepage.

Interactive Voice Response (IVR)
Also called VRU (Voice Response Unit) or ARU (Audio Response Unit). A device that routes a call automatically using a customer's replies to a series of prompted messages. An IVR may respond directly to a customer's voice or to a sequence of dialed digits (CED).

Interface
See Graphical User Interface.

Internet Explorer
The web browser developed by Microsoft Corporation. Several versions are available, providing different levels of functionality.

IP Phone
A telephone that can be integrated into an IP network.

IVR
See Intelligent Voice Response.
J
Job
A task performed by the system.

L
Label
An identifier, usually a destination number, that is associated with a specific peripheral target or with a specific network target used for call routing purposes.

Layout
The way in which information displays.

Legend
A quick means of identifying the different elements displayed in a report.

Link
The system enables you to access certain functions or pages by clicking certain text or buttons. Link text is usually distinguished from normal text by being underlined or bold.

Linked Report
When a report's parameters (items) are changed and saved under a new report name, the new report is linked in the system back to the original report.

List
A series of alphabetical or numerical objects or values.

Log in
For a user to identify themselves to the Web Portal. No user can use the Web Portal without logging in. This is a security measure which ensures that each user may only use those data and functions to which they have been granted access. This process is also called logging on (compare Log out). See Login ID, Password.

Log out
To leave the system, disabling access to functions and data. A user must log out once they have finished working with the system to prevent other individuals gaining access to functions and data they are not authorized to use (compare Log in).

Login ID
This is the same as the user name. Along with a password, it allows a user to log in to the system. See Log in, Password.

M
Mapping
The process of associating one item with another. For example, you might associate a user with a security group that has permission to access particular resources, or a security group with a resource group, or a dialed number with a destination number (label).
Member
A user who belongs to a user group.

Message
A piece of useful or instructional text.

Navigate
To search through a hierarchical folder structure in the tree, or to follow a set of commands to access a page or function within the system.

Notice
See Information Notice.

Office Web Components (OWC)
Tools based on Microsoft Excel technology, but used in the web browser rather than the desktop. They consist of the Spreadsheet, Chart, Pivot Table and Data Source components.

Online
To be able to communicate across a network.

OWC
See Office Web Components.

Parameters
Settings that enable you to define the type and amount of information displayed in a report as well as the way in which the data is presented.

Parent
A folder that contains one or more sub-folders (child folders). A parent folder sets the default security permissions of its child folders (compare with Child).

Password
A word or specific string of characters, usually consisting of letters and numbers, that is used by a given user to access an application. The word is known only to that user and acts as a security measure to ensure that each user can only access their own data and functions. See Log in, Login ID.

PDF
See Portable Document Format.

Peripheral
An individual device or switch providing routed customer phone calls to contact center staff. The term peripheral is also used to describe parts of a contact center Enterprise receiving calls from the device.
Permissions
A security measure. The set of roles a user can perform on a specific folder or folders. See also Role.

Pivot Table
An office web component that is similar to a spreadsheet, except that the row and column data values are summarized values of underlying data, which can be drilled down into to explore highly detailed report values.

Portable Document Format (PDF)
A file format developed by Adobe systems that stores documents independent of the software or hardware used to create them. A PDF document will appear exactly the same regardless of the platform on which it displays.

Prefix
A character added to a folder to specify where to place imported resources.

Print
To make a paper copy of a document or report.

Privilege
See Permissions.

Properties
The qualities possessed by an object which define it.

R
Radio button
Similar to a checkbox. A small circle displayed next to an entity in the system. By selecting the button the associated entity is made accessible for editing, deleting, and so on.

Refresh
To upload the latest data in a browser window.

Render
The process of creating a report in a specific format.

Report
A view of information or data, which is summarized and displayed numerically in a pivot table or graphically in a chart.

Resource
An entity or value in the data mart that represents an asset belonging to a customer, such as a dialed number, agent, call route, and so on. Resources are stored in folders. Also called dimensions.

Rights
See Permissions.

Role
A defined set of tasks that determine how users can interact with folders. See also Task.
Routing Script
Routing scripts are programs that determine the best way of handling a call. Reports on script activity show which reports have been called, the nodes executed within the scripts and so on.

Routing Table
A table that states which dialed number is directed to which destination number (label).

Row
In a table, a row is a horizontal line of cells spanning the columns. Each row supplies values from a certain set of data that relate to the context described by the column header. See also Column, Field.

S
Scroll
To display a new area of text within the current document or web page. This is normally accomplished using scrollbars that appear at the side or bottom of the window and indicate the user's location within the text.

Security
Any process which prevents the data held in the data mart from being viewed by unwanted users, while at the same time enabling permitted users to access the data they require.

Security Group
A collection of users who are associated with particular resources and perform particular functions according to the permissions granted to the group by the applicable user, such as creating, deleting or viewing reports.

Security Tree
A hierarchical tree in which security groups and their associated users are organized. In Unified CCMP all system resources, users and groups are stored in folders in the tree.

Session
A single period during which a user is logged into the system.

Settings
Functions that define the manner in which the user interacts with the system.

Skill Group
An organizational association of contact center agents sharing common talents such as technical or language abilities, or skills in dealing with customer complaints. Skill groups are associated with a particular peripheral and allow the ICM to route calls to the most appropriate available agent. Several skill groups at different contact centers are served by different peripherals and may be collectively combined in an enterprise skill group.

Spreadsheet
A document which displays data numerically in fields organized into rows and columns.
**State**
An item's provisioning status. There are five states: Synchronize, Error, Ready, Delete Pending and Deleted.

**Subset**
A subset of data is a portion of the data that when calculated together creates a summarized value.

**Summary**
A high level view of data; the sum of underlying data values.

**Supervisor**
A person responsible for a team of agents. A supervisor can add and remove agents and view statistics for the team that they supervise. A supervisor may also be an agent. See also Agent Team.

**System Administrator**
The highest level of user in the management system, who is responsible for creating more users and granting user permissions and access rights.

**Table**
A matrix consisting of fields, separated into rows and columns, which display values.

**Tagged Image File Format (TIFF)**
A standard image file format. The TIFF format supports multiple images and data in the same file, images of multiple pages and other options.

**Task**
An action that a user is allowed to perform. Tasks are collected together to create a Role.

**Team**
See Group, Agent Team.

**Tenant Folder**
A folder exclusive to a particular tenant. It is the same as a system folder except that a tenant folder does not and cannot inherit the security permissions of a parent folder and is a stand-alone entity (compare with Folder).

**Threshold**
A limit defined on the application server and applied to report data. Data values breaching the threshold are displayed in a manner that easily differentiates them from other data values.

**TIFF**
See Tagged Image File Format.
**Toolbar**
A list of links above the report view panel. These links are used to access the various functions and options available to the user.

**Total Field**
Totals fields display a value which represents a total or summary of all of the available data selected for analysis.

**Uniform Resource Locator (URL)**
The global address of a document or site on the World Wide Web (such as www.cisco.com).

**Uniform Resource Name (URN)**
A means of identifying resources on the Internet. An URN is a unique and unchangeable name (compare with Uniform Resource Locator).

**URL**
See Uniform Resource Locator.

**User**
An individual granted access to the application.

**User Group**
Users who share the same role assignments (security permissions).

**View**
How an item (such as a report) displays.

**Voice Response Unit (VRU)**
A device capable of routing a call automatically using a customer's replies to a series of prompted messages. A VRU may respond directly to a customer's voice or to a sequence of dialed digits. Also called IVR (Interactive Voice Response Unit) or ARU (Audio Response Unit).

**Web Archive**
A stand alone HTML file with the extension .mhtml, which contains report data in HTML code.

**Web Browser**
An application that allows a user to access the World Wide Web or locally held web pages. Web browsers include a graphical interface that lets users interact with and navigate through web pages.

**Web Server**
The web server obtains data directly from the data mart in response to user queries.

**Wrap**
A call state in which activities such as paperwork or consultations arising as a direct result of, and associated with, a customer call are completed. Also called Post-Call Processing (PCP) or After-Call Work (ACW). An agent is not available to take calls during wrap up activities.

**WYSIWYG**

What You See Is What You Get. Typically used to describe a text editor that displays formatted text.

**X**

**XML**

See Extensible Markup Language.
Index

A
About Settings 15, 19
Acrobat Portable Document Format 26
Advanced Mode 21, 31, 33
Agent Desk Settings 59
Agent Desktop 59
agent desktop templates 47
agent team templates 48
Agent Teams 53, 62, 95
agents 53, 59, 62, 64, 95, 98
Audio 79
Audit 25

B
Breadcrumb Trail 8, 11
Browsers 14
Bulk Upload 43

C
Call Types 68, 70
Change Your Password 13
Change your Security Settings 18
Change Your System Settings 16
Change Your User Settings 15
Comma Separated Variable 26

data types 44
Delete Pending 42
Deleted 42
Desk Settings 59
Desktop 59
Dialed Number 68
Directory Number 75

E
Edit Global Role 18
Edit Information Notices 21
Edit Item Security 93
Edit Report 28, 31
Enterprise Skill Groups 66
Equipment 39, 73, 77
Error 42
Expanded Call Variable 81

Expired Page 14

F
Folder 93
Inheritance 85
Manage 36, 37, 39
Folder Roles 86, 88
folder templates 47

G
Get Started 8, 10, 11
Global
Roles 87
Global Roles 86
global templates 44
Group
Default Groups 86
Grouping Data 25, 26
Manage Groups 85
Manage Groups 39
Permissions 92
Groups
Managing Groups 91

H
Help 9, 11, 14, 25
Historical Reports 25
Homepage
About 11
Displaying in 21, 28, 33
Functions available from .21, 26, 28, 33, 37

I
Information Notices 8, 21
Inheritance 85
IP Phones 39, 41, 68, 70, 73
IVR 79

L
Labels 72

M
Manage
Manage Call Types 68, 70
Manage Dialed Numbers 68, 70
Manage Expanded Call Variables 81
Manage Folders 37
Welcome

User Manual for Cisco Unified Contact Center Management Portal Release 8.5(1)